
Data Access StudioData Access Studio
Administration Guide 8.0Administration Guide 8.0

5/2/2023 Data Access Studio 8.0.13 Administration Guide

2023 - ReportsNow Inc. 1 of 145



Table of ContentsTable of Contents

 Install Guides
 E1 Install Guide
 World Install Guide

 General Administration
 System Requirements
 Data Access Studio Web Server
 Server Administration
 Users and Groups
 User Security

 Grant or Revoke Application Permissions
 Assign Users to a License Type
 Copy User Security
 Specify Which Tables a User Can Access
 Specify Which Environments a User Can Access
 Mask Address Book Information
 Enforce index use
 Allow Server Connections
 Masking Security

 Set Global Application Settings
 Generate Search
 View Audit Trail Information
 Managing User Objects

 Control All User Reports
 Transfer Everyone's Work During a JDE Upgrade
 Transfer Scheduler Tasks from user to user

 Create and Manage Folders
 Email

 Automator (Scheduling)
 The Automator Task
 Installing the Automator
 Automator Server Control
 Run Settings

 Server side External Connections
 mobie® Administration

5/2/2023 Data Access Studio 8.0.13 Administration Guide

2023 - ReportsNow Inc. 2 of 145

javascript:void(0)


 Editing mobie® Data
 Managing mobie® Users

 Adding or Editing a mobie User
 Edit Security Associations
 Import Users
 User Identities

 Managing DataBoxes
 Managing Portals

 Adding or Editing a Portal
 Portal Users
 Portal configuration and setup
 Configuring a Simple Authentication Portal
 Configuring an Azure Active Directory Portal
 Configuring an Okta Portal

 Managing mobie® content

5/2/2023 Data Access Studio 8.0.13 Administration Guide

2023 - ReportsNow Inc. 3 of 145



E1 Install GuideE1 Install Guide
Supported Versions
This Data Access Studio (DAS) guide provides comprehensive information for installing and licensing DAS. This manual describes
downloading DAS from the Download Center of the ReportsNow website and installing it to your dedicated DAS server. These
instructions apply to the following JDE E1 releases:

XE
ERP8
E1 8.9
E1 8.10
E1 8.11
E1 8.12
E1 9.0
E1 9.1
E1 9.2+

System Requirements
To successfully install and run Data Access Studio, your system must meet the following minimum requirements.

D ata Access S tudio ServerD ata Access S tudio Server
Windows Server 2012 or greater (2012, 2016, 2019 and 2022 have been certified for use by DAS)

Desktop Experience Required

2 processor cores per 20 clients (1 processor core per 20 users minimum)
Automator requires at a minimum 1.5 additional processor cores per queue

4 GB RAM per 20 clients (2GB per 20 users minimum)

Automator requires a minimum of 2GB additional memory per queue
Use of server-side summarization requires a minimum 4 GB RAM per 20 clients

.NET Framework v4.8 or greater

Internet Information Services (IIS) 8.0 or greater

ASP.NET 4.8 feature found under Web Server>Application Development when managing roles for Windows
Server.

NOTE

Note that older versions of Windows Server OS will display older ASP.NET versions such as 4.6 or 4.7 even though these options will
install ASP.NET 4.8 if .NET Framework 4.8 is installed on the server.

Windows Authentication feature found under Web Server>Security when managing roles for Windows Server

Please ensure (particularly when using Citrix) that all printer drivers are updated and viable.

Full EnterpriseOne client install Xe or higher must be installed on the DAS server.
Web development feature NOT required
Development objects (lib/source directory) NOT required

Database drivers must be patched and certified for the installed JDE client.
Since DAS only uses the database middleware and not the design tools and other parts of the client, it is generally safe to
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install EnterpriseOne clients on operating systems newer than what the Oracle certifications state. We will note here if there
are exceptions to this statement.

Please see DAS version certifications for specific Tools Versions.

For External Data Sources / Archive:

Appropriate 32-bit or 64-bit drivers for the targeted databases

For Automator:

Microsoft Excel 2013, 2016, 2019, or 2021. Excel Office 365 not supported.

NOTE

Some of these Excel versions also require a minimum OS level) Please see the current knowledge base article regarding Excel certification.

The Data Access Studio server expects to be co-located with the JDE database server as good bandwidth (and low latency) are required for
reasonable Data Access Studio performance.

D ata Access S tudio C lientD ata Access S tudio C lient
Microsoft supported edition of Windows 10 or Windows 11
4 GB RAM (2 GB Minimum)

Users running reports with large data-sets will benefit from more memory.

.NET Framework v4.8 or greater
Microsoft Excel 2013, 2016, 2019, 2021, or Office 365

Coexistence with third party Excel add-ins is not expressly supported. If a third party add-in interferes with the
execution of DAS presentations, the add-in will need to be removed.

Browser Support
Microsoft Edge (version 87 or later)
Mozilla Firefox (requires Microsoft ClickOnce plug-in)
Chrome (requires Microsoft ClickOnce plug-in)
Please review the following article for more information on browser support and required plug-ins:
https://support.reportsnow.com/hc/en-us/articles/360052866314-Web-Browsers-Compatible-with-Data-Access-
Studio

Preparing for your Data Access Studio Installation
Having the following available during your install will ensure that your installation goes as smoothly as possible:

A JD Edwards user with rights to create a table in the system data source. This user will become the initial global
administrator of DAS. This user can then give this privilege to other users after installation.
Machine that meets the above DAS server MTR
Client machine for validation

Downloading and Installing/Upgrading DAS
Follow these steps to download the latest version of Data Access Studio.

1. Download DASUpdate.exe from our Download Center to the DAS server by clicking the Download DAS8 button.

NOTE

If this is just an upgrade, and you have a Web deployment, please stop the DAS Automator service, then kill any DASWorker.exe processes
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before continuing. If you are a DAS mobie customer and have DAS mobie hosted on the same server as your DAS web server, please also
download the MOBIEPortal.zip file (click the Download Mobie button) to the same directory as DASupdate.exe so that the installer can
detect it during the installation.

2. Run the DASUpdate.exe you just downloaded to your DAS server and click Setup.

3. Click Next.

4. Please review the End User License Agreement, and if you accept the terms please click the “I Accept the Agreement” option
and click Next.
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5. Sign into JDE EnterpriseOne using an environment that is part of the EnterpriseOne client installation on the DAS server (for
example, DV920 or PD920).

If this is the first time you are installing Data Access Studio, the JDE User ID provided here must have permissions to create
and generate the “FDASPROP” table in your system data source.

6. Sign into JDEdwards.

If you do not see the EnterpriseOne (E1) sign in, you either do not have the JDE E1 dev client installed or you are a JDE
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World customer. If you are on JDE World, please refer to the Data Access Studio install guide for JDE World customers

7. The installer populates the data source field with the recommended data source.

Select the Advanced checkbox only if you wish to unzip the setup files to a directory; otherwise the files will be placed in
the user’s temp directory. If you intend to install DAS software on other additional servers (e.g. a dedicated Automator
server, or multiple DAS servers) or a Citrix deployment, then select “Advanced” and specify a network share location to
make it easier to install on the other servers.

Click Next.

The FDASPROP table is the main storage table for Data Access Studio. This is the table where DAS stores layouts, published
reports, user preferences, etc. DASUpdate.exe creates this table in your system data source to ensure that DAS users have
access to FDASPROP regardless of the environment selected when signing into DAS.

Because there is only one FDASPROP table for your entire enterprise, you do not have to worry about environments
promotion (e.g. DV->PY->PD). After DASUpdate.exe creates FDASPROP, it then creates an OCM mapping for FDASPROP.
This way DAS will always know where FDASPROP is located regardless of the signed-in environment.

NOTE

If you are applying an update/upgrade, the installer will skip the FDASPROP generation screen as it will detect that this table already exists.
In this case you will see the following window:
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8. The summarized installation plan is displayed. Click Next.

NOTE

If the JDE User ID failed to create this table, you will be prompted to enter database credentials. Please enter the database credentials to
create the table and click Next.
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9. The installer will generate the search item cache. This step could take several minutes.

10. Click Next once the search completes and you see the Deployment installation succeeded window.
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11. Once you have created the FDASPROP table, you may deploy DAS in one or more of the following ways:

Web - Your users are located in a Wide Area Network (WAN). Users run DAS from a web page link hosted by IIS
(Internet Information Services). DAS consumes resources on the DAS Web server, the user’s workstation and the
database.

Citrix - In Citrix deployment, your users do not have a JDE E1 Full client and are typically located on a WAN. Once
installed and published on Citrix, your users access the Citrix server and run DAS. DAS consumes resources from the
Citrix server and database.

Web Install Procedure
Use Web Server configuration to deploy Data Access Studio across a Wide Area Network. This configuration is the most generic
way to deploy DAS as it will work within your local area network (LAN) and in your WAN. ReportsNow recommends that you use
a dedicated machine to host Data Access Studio.

IMPORTANT

Do not use your JD Edwards deployment server as the DAS Web server. The DAS Web Server should be in close network proximity to the E1
database.

1. Once you click Next at the install summary window, you will see this window with “Launch Data Access Studio setup on this
machine” selected. Click Finish.
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2. After you click Finish, you will see the installer welcome screen. Click Next.
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3. Accept the License Agreement and click Next.

4. Unless your company policy specifies that program files should be stored on a different drive, accept the default location the
installer provides and click Next.

5. Click Install to begin the installation.

6. Once the installation is complete, click Finish.
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7. After DAS is installed on your Web server, you need to run a tool to convert it from a Workstation/Standalone mode to a
Web mode. Go to your Windows start menu and find the "Web Setup" application under your "Data Access Studio"
application folder (or "Test Environment Web Setup" under "Data Access Studio Test Environment" if you are installing a test
installation of Data Access Studio).

NOTE

If this is an upgrade, it will automatically prompt you to run Web Setup. Click Yes to continue.

8. The Web Setup utility will be displayed that allows you to change various settings for your DAS server installation. Default
settings are generally the recommended ones, though one setting you may need adjust is for the Maximum Connections.
The default setting is for 20 connections. To accommodate more users, increase Maximum Connections. For example, if you
have a total of 50 licenses, you may want to change that to 70. For more information on all the settings, please review the
tables below.

Click Setup Web when finished to apply the settings.



5/2/2023 Data Access Studio 8.0.13 Administration Guide

2023 - ReportsNow Inc. 14 of 145



Server Communication sectionServer Communication section

This section includes settings used when clients make their initial connection to IIS on the server as well as negotiating their
session.

FIELD D ES CR IPTION

Enable
SSL

If checked, clients will connect to their DAS server using encrypted SSL communication (recommended). Note that this
option will only be available if IIS is configured with an SSL certificate that is bound to the default Web site. Please consult
Microsoft documentation for instructions on installing SSL certificates in IIS.

Server
Port

Specifies the port for the IIS Web site that DAS will use to connect to. By default, this is port 80 for non-SSL connections
and port 443 for SSL connections.

Server
Name
or IP

The server network name used by clients to connect to the DAS server. This must be a network name recognized both by
the server and by client machines. It may be a partially or fully qualified DNS name or an IP address.

Using
Load
Balancer

Check this only if you are using a load balancer and the network address of this particular server must be specified
independently of the network name specified above.

This
Server's
Name

This setting is only visible if Using Load Balancer is checked and is used to specify the network address of this particular
server rather than the load balanced name that is specified under Server Name or IP.
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FIELD D ES CR IPTION

NOTE

The Enable SSL setting also dictates whether AES-256 encryption will be performed for DASWorker session communication.

DAS Worker Communication sectionDAS Worker Communication section

Once the DAS server negotiates a session for a client, further client communication is routed to a DASWorker (or
DASWorker64) process dedicated to that session on the DAS server. The following settings control the behavior of those
session communications.

FIELD D ES CR IPTION

Channel Select tcp or http. tcp performs better, but cannot traverse firewalls that perform network address translation.
Selecting tcp is incompatible with the "Clients connect via firewall" setting below.

Compress
May be used to compress data to improve performance over very slow network connections. Please note that the
performance cost of compression and decompression may be greater than the cost of network communications, so
this option should only be used over very slow network connections.

Start Port The port that the DAS Server will start with to assign client connections

Maximum
Connections

The maximum number of allowed client connections. Client sessions will fail to be created if all ports are used. Note
that external data connections can cause a second session to be created for an individual DAS client. IMPORTANT! If
you run a firewall, make sure the range of Start Port to Start Port + Maximum Connections is open. The default
setting is 20. Increase this value to be at least the number of licenses you purchased.

Lease
Timeout

The number of seconds a DASWorker process will stay alive after a client session has disconnected. When the client
session ends abnormally, this timeout ensures that the corresponding server executable gets cleaned up. Using the
default timeout is recommended. IMPORTANT! If your users experience timeouts when running DAS, try increasing
the value of this parameter.

Sign-in
Timeout

Once a user signs in, this is the number of seconds the server has to create a session for the user. If users have
trouble signing in, try increasing this value. Otherwise, the default timeout is recommended.

Idle Timeout
If set to a non-zero amount, this will set the number of minutes the software will allow the client to run before
automatically shutting it down. For instance, if this is set to 30 minutes, then if the web client is idle for 30 minutes,
the software will issue a 20 second idle warning and then shutdown the client -- thereby freeing the concurrent
license and any system resources the client held. This will not disconnect any users with unsaved work.

Clients
connect via
firewall

This should be checked in the following cases: (1) Clients connect via a firewall through which network address
translation occurs, or (2) The server has multiple network interfaces and the primary interface is not the one known by
clients. NOTE! This setting is not compatible with the tcp channel setting (http must be used).

AuthenticationAuthentication

This section includes settings for configuring how client users authenticate to the DAS server.

FIELD D ES CR IPTION
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Type Simple (default), Windows, Okta, or AzureAD (Azure Active Directory). Selecting authentication other than Simple
allows for single sign-on. Please see the Single Sign-on section for more detail.

Default
Environment

In single sign-on configurations, this field is required and denotes the JD Edwards environment that users will be
logged in to if no environment is specified in the invocation URL.

FIELD D ES CR IPTION

MiscellaneousMiscellaneous

Miscellaneous settings used during installation.

FIELD D ES CR IPTION

Reinstall
Automator
Service

When checked, Web Setup will reinstall the Windows service that is responsible for running the DAS Automator (DAS
Automator Service). Note that using this option also has the side effect of allowing you to change the Windows service
user under which all DAS related services are run.

Regenerate
Encryption
Key

DAS uses an encryption key stored in a file in the Windows %ProgramData%\ReportsNow\Key (encrypt.key) to encrypt
command line password information. For DAS test installations, this file resides in
%ProgramData%\ReportsNow\TestEnv\Key. These folders should only be readable by administrators and the DAS
service user. Use this checkbox to regenerate the encryption key.

Mixed-case
password

Check this box if you are using LDAP security or other login authentication that accepts passwords that are not all
uppercase.

9. You will be prompted with the following window. We recommend specifying a service account user that is a simple
Windows domain user without administrator rights. Note that if you are installing both a production and a test installation
of DAS on the same server, the service user for both installations must be the same. Prior to release 8.0.13, DAS required
the service user to be part of the DAS server machine's Administrators group, though beginning with release 8.0.13, this is
no longer recommended for improved security.

NOTE

If this is an upgrade, you will not be prompted for this. It will continue to use the existing service account. (One exception to this is when
upgrading from a release prior to 8.0.13 to a release that is 8.0.13 or greater.)

10. When the install is complete you will see “Setup Succeeded”.
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NOTE

(For mobie customers and mobie Upgrades only): If you are a DAS mobie customer and mobie is hosted on the DAS web server, and
you initially downloaded the DASUpdate.exe and MOBIEPortal.zip file in the same directory, it will bring up the following window. The
WebSetup and mobie configuration windows may both come up at the same time. It does not matter which order they are configured. If
the MobiePortal.zip is not in the same directory as DASUpdate.exe then you will need to select it. Click the visual assist (…) for the
installation zip file location and pick the MOBIEPortal.zip file you downloaded, then click Configure.

11. To run DAS from a browser, the URL to use will depend on the settings chosen in Web Setup, but should take one of the
following forms:

U R L W EB  S E TU P OPTIONS

https://<Server Name or IP>/DASWeb/ SSL enabled production install

https://<Server Name or IP>/DASWebTest/ SSL enabled test install
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http://<Server Name or IP>/DASWeb/ SSL disabled production install

http://<Server Name or IP>/DASWebTest/ SSL disabled test install

U R L W EB  S E TU P OPTIONS

The first time clients connect to a new version of DAS, they will be prompted with a Microsoft ClickOnce dialog where they
must click Run to download the client application files necessary to run DAS. Once DAS is loaded, the client will cache the
downloaded information so that future sign-ons go faster.

Single Sign-on
Single sign-on is the mechanism that allows invocation of DAS with credentials supplied from an alternate identity provider. DAS
supports several methods of single sign-on, each of which is detailed in this section.

JD  Edwards Trusted Node ConfigurationJD  Edwards Trusted Node Configuration

To support Windows and Okta single sign-on methods, the DAS server needs to be a Trusted Node in your JD Edwards
configuration. When switching the authentication type to Windows or Okta, the Web Setup tool will prompt for a JD Edwards
login in order to validate trusted node configuration settings as well as LDAP settings in the case of a Windows Active Directory
configuration.

If the DAS server has not yet been configured as a trusted node, you will be presented with the following dialog:
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Each of the three panes represents an element of the configuration that must be satisfied. The first element is the trusted node
configuration within JD Edwards. The above image shows what is a typical default configuration in JD Edwards where there are no
trusted nodes defined. This means that JD Edwards will use the less secure default _GLOBALNODE configuration rather than a
configuration based on trust between individual servers. The Launch JDE SSO App button in this dialog will launch the JD
Edwards SSO configuration application in a browser to allow for configuration of the DAS server as a trusted node.

IMPORTANT

Do not alter the default unless you have read the Oracle documentation about trusted node configurations carefully. Changing from the default
JD Edwards _GLOBALNODE configuration to a configuration with named Enterprise Server nodes will break existing connections from other JD
Edwards servers unless they are also configured as trusted nodes.

You may, however, accept the warning and default configuration to proceed with configuring DAS.

The middle pane generally does not require any action as the Web Setup tool in normal circumstances is able to locate necessary
components from your JD Edwards development client installation in order to update the CLASSPATH setting in your server's
jde.ini file.

The right-most pane is used to save the file %ProgramData%\ReportsNow\Key\tokengen.ini to facilitate the generation of JD
Edwards authentication tokens from the DAS server. In the default _GLOBALNODE configuration, the Node Password field is
disabled and simply clicking on the Save button will save the necessary file. If you have created a JD Edwards node configuration,
the DAS server node will have a password registered in JD Edwards. In that case, the password must be supplied in the Node
Password field prior to clicking on Save to save the necessary file.

Once all of the necessary items have been resolved, the OK button of the dialog will be enabled in order to continue on to settings
for the particular authentication type.

Windows Active D irectory/LDAPWindows Active D irectory/LDAP

This mode of single sign-on is designed for users that have configured their JD Edwards authentication to use Windows Active
Directory as an LDAP provider.

The Web Setup utility will read LDAP configuration settings from your JD Edwards configuration and automatically apply the
necessary settings. See JD Edwards documentation for a more complete discussion of configuring LDAP support in JD Edwards.
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NOTE

DAS assumes that the Windows service account user that the DAS server applications run under have sufficient privileges to read directory
information from the Active Directory/LDAP server. For this reason, the service account user should be a Windows domain user as opposed to a
user local to the DAS server machine.

LDAP single sign-on settings can be seen in the ASP.NET XML configuration file Server\web.config under your DAS installation
directory. The LDAP related settings are as follows:

S E T TING VALU E

ldap:Server The network name of your LDAP server, which is often simply your Windows domain name.

ldap:Port The port to use to connect to your LDAP server. Typically 636 for SSL connections and 389 for non-SSL connections.

ldap:USRSRCHBAS The user search basis for LDAP user queries. Typically something like "DC=mycompany,DC=com".

ldap:USRSRCHSCP The LDAP user search scope (base, subtree, or onelevel). The default is subtree.

ldap:USRSRCHATR The Active Directory attribute that is used to look up the logged on user. Typically this is sAMAccountName.

ldap:E1USRIDATR The Active Directory attribute that represents the JD Edwards user name matching the Windows Active Directory user.
This may also be sAMAccountName or a custom attribute name.

OktaOkta

The Web Setup utility presents a dialog with various configuration settings to support Okta single sign-on:

These settings must be filled in based on configuration created in your Okta administration dashboard. In Okta, you must go to
the Applications section and click the button to Create App Integration. This will present the following dialog:
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Here you will want to select OIDC - OpenID Connect. Then you will want to select Web Application as the Application Type.

On the New Web App Integration screen that follows, you will want to supply the following settings:

S E T TING VALU E

App integration name A suitable name for your integration, such as "Data Access Studio"

Grant type Authorization Code and Implicit (hybrid) should be checked

Sign-in redirect URIs
Here you will want to enter the URL of your DAS server suffixed with DASServer (or DASServerTest for a DAS
test installation) followed by authorization-code/callback. For example: 
https://DASSERVER/DASServer/authorization-code/callback .

Sign-out redirect URIs Not required

Trusted Origins Not required

Assignments>Controlled
access

This settings allows you to decide how Okta users are assigned to be able to use this app integration. Typically,
you would assign users in the same manner that you do for your JD Edwards app integration.

Once the app integration wizard is complete, you will be taken to a screen that shows the Client ID and Client secret that you
will need to record for use in the above DAS Web Setup dialog.

One additional step you will need to take in your Okta configuration is to go to Directory>Profile Editor in your Okta
administration panel. After having created the new app integration, you should see a new profile by the name of your app
integration suffixed with "User". If you named your app integration "Data Access Studio", the profile would be "Data Access Studio
User". Select that profile to edit it. Here you will want to add an attribute that represents the JD Edwards user name of your Okta
users. To do this click Add Attribute:
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You may name the attribute anything you like, though you may wish to name it the same as the attribute name that you use for
your JD Edwards integration. Once you have created the attribute, you need to map an Okta value to this attribute by clicking on
Mappings in the profile editor. Here you would select the Okta value that you use for your JD Edwards user name to map to the
new attribute:
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Now that all of your Okta settings are complete, you can return to the DAS Web Setup Okta Settings dialog to enter the following
settings:

S E T TING VALU E

Authority URL The URL to your Okta tenant - typically of the form https://companyname.okta.com/

Client ID The Client ID recorded when you created the Okta app integration.

Client secret The Client secret recorded when you created the Okta app integration.

User Claim
Name

This is the name of the Okta attribute created in the Okta profile editor for the app integration. In our example, this was
set to jde_uid.

Server Base
URL This is typically filled in correctly by default. It represents the URL to the DAS server application.

After applying the configuration with Web Setup, when users attempt to log in to DAS using the DAS launch URL, they will be
presented with an Okta login dialog where they can supply their Okta credentials to log in.

NOTE

It is not presently possible to launch DAS from the Okta login panel as the authentication must be initiated from the DAS application. You must
use the DAS launch URL (pointing to the DAS server) in order to launch DAS.

NOTE

One prerequisite for using Okta integration with DAS is that client machines must have the Microsoft Edge WebView2 runtime installed. See
Microsoft's download page for more information and links to installers. This runtime is often already installed on client machines that use Office
365 and other Microsoft applications.

Azure Active D irectory (AzureAD )Azure Active D irectory (AzureAD )

The Web Setup utility presents a dialog with various configuration settings to support Azure Active Directory single sign-on:

These settings must be filled in based on configuration created in your Azure Active Directory administration portal. In Azure
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Active Directory, you must go to App registrations and click the button for a New registration. This will present the following:

Here you will want to give a name for your application registration (e.g., "Data Access Studio"). The choice of account types would
typically be the default "Single Tenant" option. In the "Redirect URI" section, you will want to select "Web" for the platform type
and supply the URL found in the Server Base URL field in Web setup's Azure Active Directory (AD) Settings dialog (see above).

Once you click on Register, you will be taken to the Overview page of your app registration that will show the Directory
(tenant) ID and the Application (client) ID to be filled in the Azure AD Settings dialog.

In the Authentication section of your Azure App Registration, you also need to select ID tokens (used for implicit and hybrid
flows) under Implicit grant and hybrid flows.

For the Client Secret, you will need to go to Certificates & secrets in your Azure Active Directory portal, click on New client
secret to generate a new client secret. Note that the secret will only be displayed when first created, so you will want to
immediately copy the secret to the DAS Web setup configuration.

The User Claim Name setting is typically left blank as it is typical for the JD Edwards long user ID to match the UPN name of
users in Azure Active Directory. If, however, an alternate claim is defined in Azure Active Directory for use as the JD Edwards user
ID, that claim name may be specified in the settings dialog.

After applying the configuration with Web Setup, when users attempt to log in to DAS using the DAS launch URL, they will be
presented with a Microsoft Azure login dialog where they can supply their credentials to log in.
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NOTE

One prerequisite for using Azure Active Directory integration with DAS is that client machines must have the Microsoft Edge WebView2 runtime
installed. See Microsoft's download page for more information and links to installers. This runtime is often already installed on client machines
that use Office 365 and other Microsoft applications.

NOTE

In this configuration, it is necessary to stop the DASServerAppPool (or DASServerAppPoolTest for a test installation) in IIS prior to performing JD
Edwards maintenance and then restarting the AppPool when maintenance is complete.

User Login ExperienceUser Login Experience

When single sign-on is configured, users are logged in automatically with the default environment specified in the Web Setup
tool. To log in with a different environment and/or role, the user must supply this information in the invocation URL. For example,
if the default DAS invocation URL for your installation is https://DASSERVER/DASWeb/ , to specify a and environment such as
PY920 instead of the default, the user would use the following link https://DASSERVER/DASWeb/?-env=PY920 . To add a role, the
user would use a link like the following https://DASSERVER/DASWeb/?-env=PY920&-role=ACCTG .

By default, users may also bypass the single sign-on experience and supply their JD Edwards user and password. This can be done
by supplying the -nosso URL option. For example: https://DASSERVER/DASWeb/?-nosso  will log on with the DAS login screen
where the user must supply their JD Edwards user name and password.

Some administrators may wish to disallow the capability to bypass single sign-on. To disable, the DAS server administrator must
make a change on the server to disallow this capability. In the DAS server installation directory, you will find an XML file called
Remoting.txt. You must edit this file with a text editor and add an entry at the bottom of the file before the 
</DASRemotingConfiguration>  closing tag that looks as follows:

  <AllowSimpleAuth>false</AllowSimpleAuth>

To make this setting effective, the DAS server administrator must stop and restart the IIS application pool for the DAS server. The
name of this AppPool is DASServerAppPool (or DASServerAppPoolTest for a DAS test installation).

Once completed, users will no longer be able to use the -nosso URL option to bypass signing in with single sign-on.

Citrix Install Procedure
There are two primary variations on how to install DAS in a Citrix environment:

1. Citrix-only approach: Install DAS completely on the Citrix server with all of its necessary prerequisites (in particular, the
JDE client install).

2. Hybrid approach: Install DAS on a web server (see Web Install Procedure), and then install the client on the Citrix server to
connect to the DAS web server.

Citrix-only approach procedure:

Perform the Citrix install for each server where you want DAS. The Citrix server must have a full JDE E1 client install.

IMPORTANT

Prior to installing DAS, it is necessary to change the server to install mode by running “change user /install” from the command prompt. After the
installation, you must run “change user /execute” to bring it out of install mode.

1. Once you click Next at the install summary window, you will see this window. Click Finish.
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2. Click Next.
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3. Accept the License Agreement term and click Next.

4. Unless your company policy specifies that program files should be stored on a different drive, accept the default location the
installer provides and click Next.

5. Click Install to begin the installation.
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6. Once the installation is complete, click Finish.

You can now publish Data Access Studio to your users.

The executable location is the location from Step 4:

C:\Program Files (x86)\ReportsNow\Data Access Studio\DataAccessStudio.exe

Hybrid approach procedure
Installing DAS on Citrix using the hybrid approach assumes that you have already completed a normal DAS Web client installation
on another server. In this configuration, the Citrix server acts very much like a Web client with one important difference. The
difference is that the DAS client should be installed and published on the Citrix server as opposed to publishing the Web link that
Web client users would use when accessing the DAS Web server. Publishing the Web link on the Citrix server has couple of
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problems:

1. Citrix on Windows operating systems prior to Windows Server 2012 R2 do not support Microsoft .NET ClickOnce
deployment, which is what is used by DAS when connecting via the Web URL.

2. Resource consumption is much higher, because each user has their own copy of the DAS application as opposed to using
one shared installation.

To install the DAS client on the Citrix server using the Hybrid approach, you must first copy the installation/setup files from the
DAS Web server to the Citrix server. The location of the install files will be in the directory that you specified in Step 7 (under
Downloading and Installing/Upgrading DAS section).

Once you have copied over the installation files, it is necessary to change the server to install mode by running “change user
/install” from the command prompt. After the installation, you must run “change user /execute” to bring it out of install mode.
Run Setup.exe and install DAS.

Lastly, copy the file called Remoting.txt that can be found in the DAS installation directory on your DAS Web server (typically
C:\Program Files (x86)\ReportsNow\Data Access Studio\Remoting.txt) to the DAS installation directory on your Citrix server.

At this point, you will want to publish the DataAccessStudio.exe application on the Citrix server to your Citrix users.

Maintenance Considerations for Hybrid approachMaintenance Considerations for Hybrid approach

To maintain this installation, the version of DAS installed on the Web server must be kept in sync with the version installed on the
Citrix server. Any time an updated installation is performed on the DAS Web server, the Citrix server should also be updated using
the mechanism described above.

Similarly, the Remoting.txt file should also be kept in sync. If any changes to configuration options in the DAS WebSetup utility are
made on the DAS Web server, these will result in changes to the Remoting.txt file and the Remoting.txt file should again be copied
to the Citrix server.

NOTE

Some customers opt to simply copy the complete DAS Web server’s installation directory to a known, stable location on the Citrix server rather
than use the Setup.exe to install. This mechanism also works fine, though DAS will then not appear with its current version number as an
installed application on the Citrix server.

Requesting and Importing License Key
1. Sign into Data Access Studio as DAS Administrator.
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2. If you are a new customer, you will be prompted to Request License, Import License, or Cancel.

3. Click on Request License.

4. Copy and paste the information and email it to support@reportsnow.com

Once we receive the request, ReportsNow will generate a 30-day key and email you the license file. Upon receipt, save the file to a
local folder and click Import License to import the file.

DAS Administrator
As of 7.0.52 and greater, for new installs, you no longer need to create a DASADMIN user in JDE to access the Data Access Studio
as an administrator. The JDE user ID that was used to install DAS will automatically be designated to be the new DAS
administrator. You can now assign other users to be a DAS Administrator as well by giving them the “DAS Administrator”
permission under Work With Security.

Setting up DAS Automator
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DAS allows authorized users to schedule reports to run on defined Automator servers. The output of these reports can be
emailed, saved to the file system, or even saved to a database (via our mobie® product). Please verify that Excel is installed on the
DAS web server.

1. Sign into DAS as DAS Administrator

2. Click Admin > Email Providers

3. Click New Provider and configure it to reference your email system.

SMTP Example:

Exchange Example:

4. Click Test Email. This should send out a test email (to the email address listed in the ‘From Email’ field. If it is setup
correctly, it will display a dialog box saying it was successful sending the email.

5. Click OK > Save > Close

6. Click Admin > Automator to bring up the Automator Server control.

7. Click Add Server. This will bring up the Server Setup window.
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Server Name: Name of the server

Network Address: Network identification of the server with the two ‘//’ in front. Usually, this is the same name as the
server, but it can be an IP address.

Run Limit: Inherit (uses the Run Limit specified in Global Settings).

Check the Enabled box and click OK.

8. Click Add Queue button.

9. Give a name for your Queue and check the Enabled box.

10. Click the Start button under the Server section.

11. If you get any errors, try restarting the DAS Automator service in the Windows Services.
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World Installation GuideWorld Installation Guide
System Requirements
To successfully install and run Data Access Studio, your system must meet the following minimum requirements.

D ata Access S tudio ServerD ata Access S tudio Server
Windows Server 2012 or greater (2012, 2016, 2019 and 2022 have been certified for use by DAS)

Desktop Experience Required

2 processor cores per 20 clients (1 processor core per 20 users minimum)
Automator requires at a minimum 1.5 additional processor cores per queue

4 GB RAM per 20 clients (2GB per 20 users minimum)
Use of server-side summarization requires a minimum 4 GB RAM per 20 clients
Automator requires a minimum of 2GB additional memory per queue

.NET Framework v4.8 or greater

Internet Information Services (IIS) 8.0 or greater

ASP.NET 4.8 feature found under Web Server>Application Development when managing roles for Windows Server.

NOTE

Note that older versions of Windows Server OS will display older ASP.NET versions such as 4.6 or 4.7 even though these options will install
ASP.NET 4.8 if .NET Framework 4.8 is installed on the server.

Windows Authentication feature found under Web Server>Security when managing roles for Windows Server
Please ensure (particularly when using Citrix) that all printer drivers are updated and viable.
Database drivers must be patched and certified for the installed JDE client.
Since DAS only uses the database middleware and not the design tools and other parts of the client, it is generally safe to
install World clients on operating systems newer than what the Oracle certifications state. We will note here if there are
exceptions to this statement.
Please see DAS version certifications for specific Tools Versions.
IBM Client Access Versions V5R4M0 or higher and matching the JDE World server’s version. The latest service pack must
also be applied. Please note Client Solutions supersedes Client Access: https://support.reportsnow.com/hc/en-
us/articles/360001115148-IBM-Access-Client-NET-Framework-Drivers
For External Data Sources:

Appropriate 32-bit or 64-bit drivers for the targeted databases

For Automator:

Microsoft Excel 2013, 2016, 2019, or 2021. Excel Office 365 not supported.

NOTE

Some of these Excel versions also require a minimum OS level) Please see the current knowledge base article regarding Excel
certification.

The Data Access Studio server expects to be co-located with the JDE database server as good bandwidth (and low latency) are
required for reasonable Data Access Studio performance.

D ata Access S tudio C lientD ata Access S tudio C lient
Microsoft supported edition of Windows 10 or Windows 11
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4 GB RAM (2 GB Minimum)
Users running reports with large data-sets will benefit from more memory.
.NET Framework v4.8 or greater
Microsoft Excel 2013, 2016, 2019, 2021, or Office 365

Coexistence with third party Excel add-ins is not expressly supported. If a third party add-in interferes with the
execution of DAS presentations, the add-in will need to be removed.

Browser Support
Microsoft Edge (version 87 or later)
Mozilla Firefox (requires Microsoft ClickOnce plug-in)
Chrome (requires Microsoft ClickOnce plug-in)
Please review the following article for more information on browser support and required plug-ins:
https://support.reportsnow.com/hc/en-us/articles/360052866314-Web-Browsers-Compatible-with-Data-Access-
Studio

Downloading and Installing/Upgrading DAS
Follow these steps to download the latest version of Data Access Studio. Please note DAS requires .NET Framework 4.8 or
greater on the DAS server and all client machines.

1. Download DASUpdate.exe from our Download Center to the DAS server by clicking the Download DAS8 button.

NOTE

If this is just an upgrade, and you have a Web deployment, please stop the DAS Automator service, then kill any DASWorker.exe processes
before continuing. If you are a DAS mobie customer and have DAS mobie hosted on the same server as your DAS web server, please also
download the MOBIEPortal.zip file (click the Download Mobie button) to the same directory as DASupdate.exe so that the installer can
detect it during the installation.

2. Run the DASUpdate.exe you just downloaded from your DAS server and click Setup.

3. Click Next.
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4. Please review the End User License Agreement, and if you accept the terms please click the “I Accept the Agreement” option
and click Next.

5. Fill in the required fields on the next screen. Note: If this is

an upgrade, AS400 Name and Library will automatically be populated.
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Select OLEDB Provider IBMDA400.DataSource.1. If you do not see this in the available list, then you need to cancel this
install and then install Client Access OLEDB Provider 10.00 or higher.

Enter your AS400 Name

Enter the library where to find the F0094 (Library list table).

Enter your World account information: user, password and library list and click Login.

If this is the first time you are installing Data Access Studio, you need to provide the database user and password to
generate the “FDASPROP”. This table is the main storage table for Data Access Studio, for example where all reports
are stored.

NOTE

In order to generate this table, you MUST have developer rights to CREATE TABLE. This would typically require a JDE Admin
username and password for the database. If the entered username and password does not have permissions, you will be prompted
with a new window to enter the database username and password as seen below:

If the login or connection fails, the install will pop up text screens with error information. Use this information to
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trouble shoot the connection problem. If you cannot resolve the issue with the information provided, please send the
error information to support@ReportsNow.com and we can assist you.

NOTE

If you are applying an update/upgrade, the installer will skip the FDASPROP generation screen as it will detect that this table already
exists. In this case you will see the following window:

Please choose the first option (Upgrade the production install of DAS) and click Next. For more information on
running it against a test environment, please review the following article:

https://support.reportsnow.com/hc/en-us/articles/218281578

6. Once the FDASPROP table is created and DAS has been installed successfully, you may deploy DAS in one or more of the
following ways:

Web- Your users are located in a Wide Area Network. Users run DAS from a web page link hosted by IIS. DAS
consumed resources on the DAS Web server, the user’s workstation and the database.

Citrix- In Citrix deployment, your users do not have a JDE client and are typically located on WAN. Once installed and
published on Citrix, your users dial in to the Citrix server and run DAS. DAS consumes resources from the Citrix server
and database.

Web Install Procedure
1. When DAS is installed on your Web server, you need run a tool to convert it from a Workstation mode to a Web mode.

Please go to your Windows start menu and find the "Web Setup" application under your "Data Access Studio" application
folder (or "Test Environment Web Setup" under "Data Access Studio Test Environment" if you are installing a test installation
of Data Access Studio).

NOTE

If this is an upgrade, it will automatically prompt you to run the Web Setup. Click “Yes” to continue. Warning: Clicking Yes will disconnect
any active users!

2. The Web Setup utility will be displayed that allows you to change various settings for your DAS server installation. Default
settings are generally the recommended ones, though one setting you may need adjust is for the Maximum Connections.
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The default setting is for 20 connections. To accommodate more users, increase Maximum Connections. For example, if you
have a total of 50 licenses, you may want to change that to 70. For more information on all the settings, please review the
tables below.

Click Setup Web when finished to apply the settings.

Server Communication sectionServer Communication section

This section includes settings used when clients make their initial connection to IIS on the server as well as negotiating their
session.

FIELD D ES CR IPTION

Enable
SSL

If checked, clients will connect to their DAS server using encrypted SSL communication (recommended). Note that this
option will only be available if IIS is configured with an SSL certificate that is bound to the default Web site. Please consult
Microsoft documentation for instructions on installing SSL certificates in IIS.

Server
Port

Specifies the port for the IIS Web site that DAS will use to connect to. By default, this is port 80 for non-SSL connections
and port 443 for SSL connections.

Server
Name
or IP

The server network name used by clients to connect to the DAS server. This must be a network name recognized both by
the server and by client machines. It may be a partially or fully qualified DNS name or an IP address.
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Using
Load
Balancer

Check this only if you are using a load balancer and the network address of this particular server must be specified
independently of the network name specified above.

This
Server's
Name

This setting is only visible if Using Load Balancer is checked and is used to specify the network address of this particular
server rather than the load balanced name that is specified under Server Name or IP.

FIELD D ES CR IPTION

> [!NOTE]
> The **Enable SSL** setting also dictates whether
> AES-256 encryption will be performed for DASWorker session communication.

### DASWorker Communication section

Once the DAS server negotiates a session for a client, further client communication
is routed to a DASWorker (or DASWorker64) process dedicated to that session on the DAS server.
The following settings control the behavior of those session communications.

| **Field**    | **Description**                                                                                       
|
|----------|--------------------------------------------------------------------------------------------------
-|
| Channel  | Select tcp or http. tcp performs better, but cannot traverse firewalls that perform network 
address translation. Selecting tcp is incompatible with the "Clients connect via firewall" setting below. |
| Compress | May be used to compress data to improve performance over very slow network connections. Please 
note that the performance cost of compression and decompression may be greater than the cost of network 
communications, so this option should only be used over very slow network connections. |
| Start Port | The port that the DAS Server will start with to assign client connections |
| Maximum Connections | The maximum number of allowed client connections. Client sessions will fail to be 
created if all ports are used. Note that external data connections can cause a second session to be created 
for an individual DAS client. **IMPORTANT!** If you run a firewall, make sure the range of Start Port to Start 
Port + Maximum Connections is open. The default setting is 20. Increase this value to be at least the number 
of licenses you purchased. |
| Lease Timeout                         | The number of seconds a DASWorker process will stay alive after a 
client session has disconnected. When the client session ends abnormally, this timeout ensures that the 
corresponding server executable gets cleaned up. Using the default timeout is recommended. **IMPORTANT!** If 
your users experience timeouts when running DAS, try increasing the value of this parameter.                                                                                  
|
| Sign-in Timeout                        | Once a user signs in, this is the number of seconds the server has 
to create a session for the user. If users have trouble signing in, try increasing this value. Otherwise, the 
default timeout is recommended.                                                                                                                                                                                                                                                     
|
| Idle Timeout                          | If set to a non-zero amount, this will set the number of minutes the 
software will allow the client to run before automatically shutting it down. For instance, if this is set to 
30 minutes, then if the web client is idle for 30 minutes, the software will issue a 20 second idle warning 
and then shutdown the client -- thereby freeing the concurrent license and any system resources the client 
held. This will not disconnect any users with unsaved work. |
| Clients connect via firewall          | This should be checked in the following cases: (1) Clients connect 
via a firewall through which network address translation occurs, or (2) The server has multiple network 
interfaces and the primary interface is not the one known by clients. **NOTE!** This setting is not compatible 
with the tcp channel setting (http must be used). |

### Authentication

This section includes settings for configuring how client users authenticate to the DAS server.

| **Field**    | **Description**                                                                                       
|
|----------|--------------------------------------------------------------------------------------------------
-|
| Type | Simple. This field is disabled as World installations only support simple authentication. |
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| Default Environment | When using DAS legacy SSO, this field indicates the default environment that will be 
used if no environment has been specified. |

### Miscellaneous

Miscellaneous settings used during installation.

| **Field**    | **Description**                                                                                       
|
|----------|--------------------------------------------------------------------------------------------------
-|
| Reinstall Automator Service | When checked, Web Setup will reinstall the Windows service that is responsible 
for running the DAS Automator (DAS Automator Service). Note that using this option also has the side effect of 
allowing you to change the Windows service user under which all DAS related services are run. |
| Regenerate Encryption Key | DAS uses an encryption key stored in a file in the Windows 
%ProgramData%\ReportsNow\Key (encrypt.key) to encrypt command line password information. For DAS test 
installations, this file resides in %ProgramData%\ReportsNow\TestEnv\Key. These folders should only be 
readable by administrators and the DAS service user. Use this checkbox to regenerate the encryption key. |
| Mixed-case password | Check this box if you are using LDAP security or other login authentication that 
accepts passwords that are not all uppercase.  |

1. You will be prompted with the following window. We recommend specifying a service account user that is a simple
Windows domain user without administrator rights. Note that if you are installing both a production and a test installation
of DAS on the same server, the service user for both installations must be the same. Prior to release 8.0.13, DAS required
the service user to be part of the DAS server machine's Administrators group, though beginning with release 8.0.13, this is
no longer recommended for improved security.

NOTE

If this is an upgrade, you will not be prompted for this. It will continue to use the existing service account. (One exception to this is when
upgrading from a release prior to 8.0.13 to a release that is 8.0.13 or greater.)

2. When the install is complete you will see “Setup Succeeded”.
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NOTE

For mobie customers and mobie Upgrades only: If you are a DAS mobie customer and mobie is hosted on the DAS web server, if you
initially downloaded the DASUpdate.exe and MOBIEPortal.zip file in the same directory, it will bring up the following window. The
WebSetup and mobie configuration windows may both come up at the same time and it does not matter which order they are configured.
If the MobiePortal.zip is not in the same directory as DASUpdate.exe then you will need to select it. Click the visual assist (…) for the
installation zip file location and pick the MOBIEPortal.zip file you downloaded, then click Configure.

3. To run DAS from a browser, the URL to use will depend on the settings chosen in Web Setup, but should take one of the
following forms:

U R L W EB  S E TU P OPTIONS

https://<Server Name or IP>/DASWeb/ SSL enabled production install

https://<Server Name or IP>/DASWebTest/ SSL enabled test install
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http://<Server Name or IP>/DASWeb/ SSL disabled production install

http://<Server Name or IP>/DASWebTest/ SSL disabled test install

U R L W EB  S E TU P OPTIONS

The first time clients connect to a new version of DAS, they will be prompted with a Microsoft ClickOnce dialog where they
must click Run to download the client application files necessary to run DAS. Once DAS is loaded, the client will cache the
downloaded information so that future sign-ons go faster.

Citrix Install Procedure
There are two primary variations on how to install DAS in a Citrix environment:

1. Citrix-only approach: Install DAS completely on the Citrix server with all of its necessary prerequisites (in particular, the
JDE client install)

2. Hybrid approach: Install DAS on a web server (see Web Install Procedure), and then install the client on the Citrix server to
connect to the DAS web server.

C itrix-only approachC itrix-only approach

After you have installed Data Access Studio, publish DataAccessStudio.exe application to your Citrix users.

Executable location is:

C:\Program Files (x86)\ReportsNow\Data Access Studio\DataAccessStudio.exe

Hybrid approach procedureHybrid approach procedure

Installing DAS on Citrix using the hybrid approach assumes that you have already done a normal DAS Web client installation on
another server. In this configuration, the Citrix server acts very much like a Web client with one important difference. The
difference is that the DAS client should be installed and published on the Citrix server as opposed to publish the Web link that
other Web client users would use when accessing the DAS Web server. Publishing the Web link on the Citrix server has numerous
problems:

1. Citrix on Windows operating systems prior to Windows Server 2012 R2 do not support Microsoft .NET ClickOnce
deployment, which is what is used by DAS when connecting via the Web URL.

2. Resource consumption is much higher, because each user has their own copy of the DAS application as opposed to using
one shared installation.

To install the DAS client on the Citrix server, please copy the Data Access Studio folder located on the DAS Web server
(C:\Program Files(x86)\ReportsNow\) to a location on your Citrix server.

At this point, you will want to publish the DataAccessStudio.exe application on the Citrix server to your Citrix users.

Maintenance Considerations for Hybrid approachMaintenance Considerations for Hybrid approach

To maintain this installation, the version of DAS installed on the Web server must be kept in sync with the version installed on the
Citrix server. Any time an updated installation is performed on the DAS Web server, the Citrix server should also be updated using
the mechanism described above.

Similarly, the Remoting.txt file should also be kept in sync. If any changes to configuration options in the DAS WebSetup utility are
made on the DAS Web server, these will result in changes to the Remoting.txt file and the Remoting.txt file should again be copied
to the Citrix server.
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Requesting and Importing License Key
1. Sign in to Data Access Studio as DAS Administrator

2. You will be prompted to Request License, Import License, Cancel.

3. Click on Request License.

4. Copy and paste the information and email it to support@reportsnow.com

Once we receive the request, ReportsNow will generate a 30 day key and email you the license file. Upon receipt, save the file to a
local folder and click on Import License to import the file.

DAS Administrator
As of 7.0.52 and greater, for new installs, you no longer need to create a DASADMIN user in JDE to access the Data Access Studio
as an administrator. The JDE user ID that was used to install DAS will automatically be designated to be the new DAS
administrator. You can now assign other users to be a DAS Administrator as well by giving them the “DAS Administrator”
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permission under Work With Security.

Setting up DAS Automator
DAS allows authorized users to schedule reports to run on defined Automator servers. The output of these reports can be
emailed, saved to the file system, or even saved to a database (via our mobie® product). Please verify that Excel is installed on the
DAS web server.

1. Sign into DAS as DAS Administrator

2. Click Admin | Email Providers

3. Click New Provider and configure it to reference your email system.

SMTP Example:

Exchange Example:

4. Click Test Email. This should send out a test email (to the email address listed in the ‘From Email’ field. If it is setup correct,
it will bring up a dialog box saying it was successful sending the email.

5. Click OK > Save > Close
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6. Click Admin > Automator to bring up the Automator Server control.

7. Click Add Server. This will bring up the Server Setup window.

Server Name: Name of the server

Network Address: Network identification of the server with the two ‘//’ in front. Usually the same name as the server but
can be an IP address.

Run Limit: Inherit (uses the Run Limit specified in Global Settings).

Check the Enabled box and click OK.

8. Click Add Queue button.

9. Give a name for your Queue and check the Enabled box.

10. Click the Start button under the Server section.

11. If you get any errors, try restarting the DAS Automator services in the Windows Services.

For more information on DAS administration, please review the Administration Guide by signing into DAS as the DAS
Administrator, then choosing Help->Administration Guide.
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IntroductionIntroduction
The Data Access Studio (DAS) Administrator typically has high technical knowledge of the Oracle JD Edwards (JDE) system:
network architecture, database, deployment, etc. The Administrator controls how all other users access and use Data Access
Studio.

This guide discusses how to administer:

Setting up an administrator user
Installation
Web server
User licenses
Security
Audit trail
Transferring a user's work
Upgrades
Automator
mobie® Administration

Create an Administrator User
The initial user that installed DAS will be designated as a DAS administrator. This user can assign this designation to other users.

General notes about the DAS Administrator:

Has access to the special Admin menu.
Only user that can import new license files
Has access to all layouts and reports.
Can manage layouts and reports of JDE users such as contractors who are no longer with your company.
While a DAS administrator has visibility to all private reports, this user cannot open those reports. Instead, the report must
first be copied to this user prior to opening the report.

Oracle and JD Edwards are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their
respective owners.
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Recommended System RequirementsRecommended System Requirements
Because Data Access Studio bolts onto JDE, Data Access Studio runs on any database or system that JDE runs on. Please go to the
ReportsNow Support Site for the up-to-date system requirements.

Installation
The ReportsNow web site contains all current installation instructions.
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Data Access Studio Web ServerData Access Studio Web Server
The Data Access Studio Server provides web-based deployment of the dedicated Data Access Studio clients. This server also is the
centralized gateway to your enterprise's data for all the DAS clients.

This mode of operation has the following benefits to an organization:

Light clients. Client machines do not require an EnterpriseOne Full Client Install nor World ODBC drivers.
Edit and run reports. User interface is far superior to HTML only.
Easy to administer. Data Access Studio Web Server is the only place where you need to update software.
High performance. Data transfer is far superior to HTML.
Load balanced. Web mode distributes processor and memory load to client PCs.
Secure. Web based deployment mode supports all standard encryption modes including AES.
Scalable. Add as many Data Access Studio Web Servers as you need. Or increase server processor power or RAM to support
more users (see System Requirements).

Architecture

1. A Windows client is deployed via a seamless ClickOnce web deployment launched from a URL from a browser.
2. The Windows client connects to the DAS Server using HTTP or TCP/IP.
3. Once connected, the DAS Server service creates a DASWorker to host the client's requests.
4. The DAS Worker accesses JDE through EnterpriseOne (OneWorld) security or through Data Access Studio World security.
5. The DAS Server and database pass through data to the Web client. The majority of the processing power and memory is on

the Web client.

The result is a scalable solution that compromises none of the rich user interface capabilities of DAS.

To install the Web Server, please refer to the Installation Guide.

EnterpriseOne Notes
For JDE EnterpriseOne, you will need to install one or more E1 packages on the DAS Web Server. Each package you install (for
example PD, PY, etc.) will make that environment available to the user.
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Server AdministrationServer Administration
Once you have the Web server installed and running, refer to the following tasks to maintain its operation.

Update DAS Web Server with new version of Data Access Studio
As ReportsNow enhances Data Access Studio, you will need to update the Data Access Studio software itself. To update the DAS
Server with new Data Access Studio software:

1. Schedule update off-hours.

2. Notify users of update.

3. At the time of the update follow instructions contained in one of these install guides:

JD Edwards Enterprise One
JD Edwards World

EnterpriseOne Only - Update DAS Web Server with new E1 Client
Package
If you make custom table modifications, you will need to update the E1 client package on the DAS Web server. To update the E1
client package:

1. Schedule update off-hours.

2. Notify users of update.

3. At the time of the update:

1. From Windows click Start | Control Panel | Administrative Tools | Services

2. Stop the Data Access Studio Service. Once stopped, users will not be able to log into DAS (which is what you want
for this stage).

3. Run Task Manager. Stop any running DASWorker.exe process.

4. Install the E1 Client package(s). Alternatively, you can log in to Object Management Workbench and do a "Get" on the
new and changed object specifications. This is especially useful if there are only a handful of changes.

5. Start the Data Access Studio Service. Start the DAS Automator Service

6. If there are new objects or significant changes in existing objects, you will want to run the 'Generate Search' command
from the Admin menu so that these objects are included when searching from the home page in DAS.

Windows Service User
The Web Setup utility used during installation requires a Windows service user to run the DAS Automator Windows service and
two of the IIS application pools associated with DAS: the DASServerAppPool and the DASAutomatorAppPool.

In current versions of DAS, this Windows service user does not need to be a member of the Windows Administrators group and
for better security should not be. The Web Setup utility grants this user the following rights to ensure that it can properly run DAS
services:

1. Read/write access to the jde.ini file (typically in C:\WINDOWS). Required by the JD Edwards development client.
2. Read/write access to the %ProgramData%\ReportsNow folder, though only read access to the Key subfolder.
3. Read/write access to Windows system desktop profile folders: (C:\WINDOWS\System32\config\systemprofile\Desktop and
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C:\WINDOWS\SysWOW64\config\systemprofile\Desktop). Required for Excel automation.
4. Read/write access to JD Edwards development client spec directories. Required for caching specs.
5. Read/write access to HKEY_LOCAL_MACHINE\SOFTWARE\ReportsNow 32-bit and 64-bit registry keys.
6. DCOM local launch and activation permissions for Microsoft Excel Application.
7. Windows log on as a service permission.
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Users and GroupsUsers and Groups
Data Access Studio inherits and extends the user models of World and Enterprise One. In addition to the users and group/roles
that your system defines, DAS provides a special group called DASUSERS that exists only in DAS and is the equivalent of all users
that have access to DAS. It is possible to configure security and publish reports to DASUSERS, groups/roles, or an individual user.

Enterprise One (post-XE)
Enterprise One specifies users and roles. Each user can be associated with multiple roles. In addition, an E1 user has a special *ALL
role that, if logged into, is the same as logging in to a sub-set (usually all but not always) of the roles the user belongs to.

Your users can publish to a user, role, or DASUSERS. All subscribers will see reports published to DASUSERS. A user must be
logged in as *ALL or the published-to role to see a report published to one of groups that user belongs to.

You can define DAS security for DASUSERS, a role, or a user. For most security configuration, the most granular defined entity
(DASUSERS, role, or user) will be used for a user. If role is the most granular for a given user and the user logged in as *ALL, then
roles are merged. For some security configuration, information from each level (DASUSERS, role, and user) will be merged
together. See User Security for more information.

Enterprise One (XE)
Enterprise One XE specifies users where each user can belong to one and only one group.

Your users can publish to a user, group, or DASUSERS. All subscribers will see reports published to DASUSERS.

You can define DAS security for DASUSERS, a group, or a user. For most security configuration, the most granular defined entity
(DASUSERS, group, or user) will be used for a user. For some security configuration, information from each level (DASUSERS,
group, and user) will be merged together. See User Security for more information.

World (A9.3 and later)
As of A9.3, World specifies users and roles. Each user can be associated with multiple roles. Each role can be associated with many
groups. Security in World is still defined in terms of groups and users. Unlike World, DAS allows a user to login using a special
*ALL role. The *ALL role indicates to use all the roles that user is allowed to sign into.

Your users can publish to a user, group, or DASUSERS. All subscribers will see reports published to DASUSERS. A user must be
logged in as *ALL or the published-to group to see a report published to one of groups that user belongs to. See Published
Reports Business Unit Security for special notes on publishing reports with roles in A9.3.

You can define DAS security for DASUSERS, a group, or a user. For most security configuration, the most granular defined entity
(DASUSERS, group, or user) will be used for a user. If group is the most granular for a given user and the user logged in as *ALL,
then roles are merged. For some security configuration, information from each level (DASUSERS, group, and user) will be merged
together. See User Security for more information.

World (pre-A9.3)
World prior to A9.3 specifies users where each user can belong to one and only one group.

Your users can publish to a user, group, or DASUSERS. All subscribers will see reports published to DASUSERS.

You can define DAS security for DASUSERS, a group, or a user. For most security configuration, the most granular defined entity
(DASUSERS, group, or user) will be used for a user. For some security configuration, information from each level (DASUSERS,
group, and user) will be merged together. See User Security for more information.
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User SecurityUser Security
DAS Security and JDE Security
Data Access Studio extends the JD Edwards security model by providing application-level security.

For maximum flexibility and minimum redundancy, Data Access studio gives you three options for specifying a set of users (in
order of highest granularity to lowest):

1. JD Edwards user name

2. JD Edwards groups or roles

3. All Data Access Studio users (DASUSERS)

These three options match up with your World or Enterprise One system. See the Users and Groups section for more information.

If your security definitions overlap for a given user, the definition with the highest granularity wins. For instance, if you defined
security to DASUSERS and to a specific User Name, the permissions of the specific User Name win out because it is more granular
than "All users".

Permissions
Permission Inheritance for Enterprise One (post-XE) and World (A9.3 and later):

If you have configured DAS security in terms of roles (E1) or groups (A9.3) and your user signed in as *ALL for the role, all the
roles/group records for that user are merged together with the rule that granting access overrules denying access. This merging
behavior can be changed to a more simple 'first-wins' configuration using a global preference setting.

G rant or Revoke PermissionsG rant or Revoke Permissions

Permissions for all users can be granted or revoked by an administrator. Refer to the Grant or Revoke Permissions article for how
to manage permissions for users.

The following security settings will automatically inherit the security from a more general group of users that you defined. In this
case, you will see an Inherited indicator. For Inherited you will typically have the option to enable or disable it.

Table and Business View Security
Address Book Security
Index Use Enforcement
Server External Connection Access
Masking Security

DAS US E R  PermissionsDAS US E R  Permissions

DAS provides a special group called DASUSERS that exists only in DAS and is the equivalent of all users that have access to DAS. It
is possible to configure security and publish reports to DASUSERS, groups/roles, or an individual user.

IMPORTANT

We strongly recommend users configure the DASUSERS security role to supply a default set of permissions.

The reason for this is that in the absence of any matching security record (no user, group/role, or DASUSERS), the default is to grant all
permissions, except those permissions that require Admin or a Security Record defined.

I f No DAS US E R  Permission is D efinedI f No DAS US E R  Permission is D efined
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When no DASUSER security is supplied, such as when a JDE user signs into DAS without having specific permissions setup for
that user, all permissions will be granted to that signed in user except the following:

Private Reports

 Can design report with blob contents
 Can view Data Access Studio property blobs

Scheduling

 Can Manage Automator

Data Access Studio Administration

 Is Administrator
 Is mobie Administrator

IMPORTANT

We strongly recommend administrators create a security role for each JDE user that will sign into DAS and supply a default set of
permissions. This will allow the user with a security role to inherit the DASUSER security permissions. Additional permissions can be granted
or revoked for those users with a security role defined. See Setup Security for Users below.

Table PermissionsTable Permissions

Users and Groups can be restricted from accessing specific tables. This is helpful when certain users or groups shouldn't see
Human Resource tables for example. Refer to the article on Table Permissions to create security restrictions.

Environment PermissionsEnvironment Permissions

Users can be included or restricted from accessing specific environments, such as a test environment vs a production
environment. Refer to the article on Environment Permissions to create security restrictions.

Address B ook Masking PermissionsAddress B ook Masking Permissions

Certain fields in a table can be restricted for users. Helpful for restricting information such a Tax Id, Address, Phone, etc. Refer to
the article on Address Book Permissions or Masking Security to create security restrictions.

Recommended Permission Sett ingsRecommended Permission Sett ings

TIP

In general, we recommend revoking the following security permissions to prevent unwanted user behavior such as accidentally deleting another
user's reports, etc.

Uncheck the following permissions:

Lists

 Can Delete

Presentation Styles

 Can Delete

Published reports

 Can overwrite reports published by others
 Can move to folder
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 Folder administrator

Scheduling

 Can Manage Automator

ProReports

 Can Use Any Published Subreport

Setup Security for Users
To setup application level security:

1. Sign in as a user with DAS Administrator rights.

2. Select Admin | Work With Security.

TO D O THIS

Add security for
a user or group

Click the empty box under the User ID column. Select a user or role (group for XE or World). Click the security category
tabs to the right to set security settings (see below.)

Delete security
for a user or
group

Click on row on the left-hand side. Click Delete.

Modify security
for a user or
group

Click on the row for the user or group. Edit the settings in the category tabs to the right.

Save your
settings Click Save

Exit without
changing
settings

Click Close (without clicking Save first)
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Restore security
settings from
backup

When you click Save, DAS writes a backup of the current record. If that succeeds, then DAS commits the new changes
to the security definition. If you need to restore security settings from the last backup, click **Restore from backup.

TO D O THIS

Copy User Security
Security Permissions can be copied from one user to another in the Work with Security form. Refer to the article on Copying user
Security for how to copy security permissions.

User License Type
Data Access Studio supports license types for users which also restrict some permissions. The two types of licenses are Designer
and Subscriber. Refer to the article on Assigning Users to a License Type for how to specify a user as a Designer or a
Subscriber.
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Application PermissionsApplication Permissions
Click the Permissions tab to grant and revoke action permissions to the selected user or group.

For clarity, each permission has an image that indicates whether that permission is defined as a Subscriber , or Designer . In
addition, the culmination of the user's granted permissions determines whether the user is a Subscriber or Designer.

TO G R ANT OR R EVOK E AB ILIT Y TO
CHECK  (G R ANT) OR
U NCHECK  (R EVOK E)

Bursting

Allow user to drill from one report into another  Can Drilldown

Allow user to have a report call a sub-report (aka Burst)  Can Burst

Allow user to email and file copy burst results  Can Distribute Burst
Result

Data Access Studio Administration

Allow a user to administer DAS including giving permissions to any user.  Is Administrator

Allow a user to administer mobie. Requires a mobie license.  Is mobie Administrator

External Data

Allow user to use External (non-JDE) data sources  Can use client side
connections

Allow user to access server side connections (See Server-side External Data connections)  Can use server side
connections

Import/Export DAS objects

5/2/2023 Data Access Studio 8.0.13 Administration Guide

2023 - ReportsNow Inc. 57 of 145



Export Data Access Studio layouts to a flat file  Can export DAS objects

Import Data Access Studio layouts from a flat file  Can import DAS
objects.

Lists

Allow user to delete published lists  Can Delete

Allow user to publish lists  Can Publish

mobie®

Allow a user to web publish a dashboard or ProReport Can Publish

Presentation Styles

Allow user to delete published presentation styles  Can Delete

Allow user to publish presentation styles  Can Publish

Allow viewing the pre-built styles delivered with DAS  Can View Pre-built
Styles

Private Reports

Create and modify private reports  Can create and modify
private reports.

Open private reports  Can open private
reports.

Enable layout to issue a sort and/or grouping commands to the database. Sorting and grouping can have
significant performance impact on a database.

 Can enable sort and
grouping at database.

Allow user to do server-side grouping (useful for very large datasets). This grouping is done on the DAS
server (not the database)

 Can do grouping on
server

Give the user an extra 'Find' button that will return the count of all the records the query would
return in addition to returning the first 100 records. Increases database load.

 Can do find with count.

Allow user to create and edit table joins  Can edit join

Allow a designer access to a blob column in a table. Disabled by default. Can design report with
blob contents

TO G R ANT OR R EVOK E AB ILIT Y TO
CHECK  (G R ANT) OR
U NCHECK  (R EVOK E)
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Allow a designer to view the blob in the FDASPROP table. Can view Data Access
Studio property blobs

ProReports

Allow users to create a ProReport against DAS Reports  Can design ProReports

View any published subreport that is used by a ProReport published to the user even if that user does not
directly subscribe to the published subreport.

 Can Use Any Published
Subreport

Published reports

Run reports published to user  Can use published
reports

Publish reports to other users  Can publish reports

Delete published reports  Can delete

Copy a published report to private layout  Can copy to private
report

Overwrite the published report of another user  Can overwrite reports
published by others

Allow publishing reports to a specific folder.  Can move to folder

Make user a Folder Admin (see Create and Manage Folders)  Folder administrator

Quick Reports

Allow access to Financial Quick Reports  Financials

Allow access to Fixed Assets Quick Reports  Fixed Assets

Allow access to Job Cost Quick Reports  Job Cost

Scheduling

Allow user to schedule reports  Can Schedule

Allow a user to categorize (i.e. tag) a task. Tags are used for such things as changing the run priority of a task.  Can Add Tags To Tasks

Allow a user to change the recovery settings (relaunch after an error or a skipped scheduled instance) of a
task.

 Can Change Job
Management

Allow a user to fully manage the DAS Automator system. A DAS Administrator always has this permission.  Can Manage
Automator

TO G R ANT OR R EVOK E AB ILIT Y TO
CHECK  (G R ANT) OR
U NCHECK  (R EVOK E)
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Tables and Views

Open JDE or External tables and views  Can open tables and
views

Override default datasource when opening a JDE table  Can open in any data
source

Third Party Integration

Embed Excel into layouts at design-time  Can Embed Excel

TO G R ANT OR R EVOK E AB ILIT Y TO
CHECK  (G R ANT) OR
U NCHECK  (R EVOK E)
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Assign Users to a License TypeAssign Users to a License Type
Data Access Studio supports two types of users:

U S ER
T YPE NOTES

Designer

Designs and publishes reports. Has access to all of the Data Access Studio functionality (less any secured functionality). In order
to run Data Access Studio you must have at least one full user. If you purchased Full users only, no additional setup is required
here.

Subscriber
May only run published reports. If you purchased Subscriber licenses, you must designate which users are the
Subscriber users (see below).

Designate a User or Group as a Subscriber
1. Sign in as a user with DAS Administrator rights.

2. Select Admin | Security.

1. Select one or more users on the left-hand side (use CTRL to multi-select)

2. You can click the Make subscriber only button to change any user's permissions to subscriptions only, or you can change
each granted permission individually, granting only the  Subscriber permissions.

NOTE

Granting any  Designer permission will result in the user becoming a DAS Designer.

Special Consideration for Single Report Mode
If you have subscriber licenses available, a designer will consume a subscriber license instead of a designer license when opening
a report in single report mode. If no subscriber licenses are available, a designer license will be consumed instead.

This is the only special case where a user with designer permissions can consume a subscriber license.

Single Report Mode (srm) is a special mode to launch DAS to run for one and only one report by passing the '-srm' option via
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URL or command-line parameter. This parameter is automatically added to the URL when a Published Workspace folder admin
copies a URL for a published report. This mode is often used to invoke reports from a menu such as JDE E1's.
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Copy User SecurityCopy User Security
This feature allows a DAS Administrator to copy any security record to a new user or multiple new users in the Work With
Security form.

For example, if you wanted to copy the TEST user to MATT and DEMO users:

select TEST user

click the  toolbar button

choose MATT and DEMO users from the Valid Values form (Ctrl+click to multi select)

then press the  button

This will result in two new user records, having the same security permissions as TEST
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Note: You cannot overwrite existing users. If you would like to replace an existing user record, simply delete the user row and
perform the Copy User steps listed above.
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Table PermissionsTable Permissions
Click the Filter Tables and Views tab to restrict which tables a user or group can access. To reduce redundancy, Data Access
Studio organizes table filter by the following hierarchy:

DASUSERS

Group or Role

User

DASUSERS represents all users of the software. Use this level to apply global security filters. For example, if you lock DASUSERS
out of all tables, then everyone is locked out of all tables by default.

Use Group (World) or Role (E1) to apply security filters for a group of users. Any security on this level can override DASUSERS
security.

Use User to apply security filters for a specific user. Any security on this level can override DASUSERS and Group security.

Example

To illustrate how security is built up with the inheritance model, we will examine the following setup:

Lock out all users from all tables

Let all users have access to Product codes 00 through 04 and greater than 10

Let TEST have access to Product codes 05 through 09

1. Sign in as a user with DAS Administrator rights.

2. Click Admin | Security

3. Under User ID, add a row for DASUSERS

4. On the Filter Tables and Views tab, enter SYin the Alias column. Click the  Filter Helper button in the Filter Criteria
Column. Select <05;>=09:

This basically says that by default, only allow users to access tables less than system code 05 or greater than or equal to system
code 09 (thereby excluding the range 05 through 08)

1. Add a record for TEST (or select it if it already exists).

2. Simply un-check the 'Enable' flag for the inherited rule from DASUSERS. TEST can now see everything.
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Environment PermissionsEnvironment Permissions
You can restrict which environments a user may access by either:

Specifying a list of environments that the user is limted to

Or, specifying a list of prohibited environments

This security appears on the Environment Security tab for a given user.

Example 1 - Restrict all users to environment PD910

1. Sign in as a user with DAS Administrator rights.

2. Click Admin | Security

3. Add a user row for DASUSERS (or select the DASUSERS row if it is already present).

4. Click on the Environment Security tab

5. In the Include/Exclude column, select Include.

6. In the Environment column, enter PD910.

Example 2 - Allow all users to sign into any environment except for PD910 and PY910:

1. Sign in as a user with DAS Administrator rights.

2. Click Admin | Work With Security

3. Add a user row for DASUSERS (or select the DASUSERS row if it is already present).

4. Click on the Environment Security tab

5. In the Include/Exclude column, select Exclude.

6. In the Environment column, enter PD910.

7. Tab to the next row. In the Include/Exclude column, select Exclude.

8. In the Environment column, enter PY910.
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Address Book PermissionsAddress Book Permissions
Address Book Security lets you mask select fields for certain address book users. The most common application for this type of
security is to mask sensitive information such as Tax Id, Address, Phone, for Employees. Address Book Security is great option
when you are not using JDE Row or Column Security to take care of this. Address Book Security, however, is a more flexible way
to secure sensitive information. First, the security masks out certain fields (vs. blocking the entire column or row). Second, the
security works over multiple tables. Third, the Address Book Security implements default inheritance to save you time: any new
security record you add will automatically inherit the field masking from its group or DASUSERS (whichever it finds first
respectively and assuming the user does not also specify address book masking).

Example

For all users, secure the Tax ID and Salary fields for employees:

1. Sign in as a user with DAS Administrator rights.
2. Click Admin > Security
3. Add a user row for DASUSERS (or select the DASUSERS row if it is already present).
4. Click on the Address Book Security tab
5. In the Address criteria field = field group, select AT1 (search Type) with the visual assist. In the filter field, type E

(Employee).
6. In the Data Items to mask group, type SSN (then Tab out). Type TAX (then Tab out). Then type SAL (and Tab out).

With this setup, when any Data Access Studio user signs in and queries any table with an address number (e.g. Employee Master,
Employee History, Accounts Payable, ...), then if the address number is an employee (i.e. Search Type E), Data Access Studio will
blank out the SSN, TAX, and SAL fields.

Using this approach, you can add additional Data Items to the Data Items to mask. E.g. addresses, phone number, email, etc.

If you add a new user security record, by default it will inherit the Address Book Security of its parent.

WARNING

Reports with table lookups fetching against tables that include the AN8 column but do not include this column in the returned column set will
mask all rows of the masked columns. When implementing this security, make sure to inform your developers of your more complex reports.
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Enforce Index UseEnforce Index Use
Enforce index use security lets you set index usage levels by table, ensuring you are always using a defined index during queries.
This is important on your large transaction tables such as the Account Ledger Table (F0911). Querying using an index - even if it is
just part of an index - is key to not only writing reports that run fast but also at keeping your overall database load at an
acceptable level for all your users of the database.

We highly recommend specifying your high-use large transaction tables for all users at a 'Required Index Use Percentage' of 20%.

1. Sign in as a user with DAS Administrator rights.

2. Click Admin > Security.

3. Add a user row for DASUSERS (or select the DASUSERS row if it is already present).

4. Click on the Index Use tab.

5. In the Table Name field enter the name of a JDE table (ex. F0901).

6. In the Required Index Use Percentage field, enter a number that represents a percentage. (For example, a value of 20 will
require any query against the table to use at least 20% of at least one of the indexes on that table. In other words, if the
index has five columns, 20 indicates that at least one column of the index must be used or DAS will not allow the query to
be executed).

Note: Table queries without filtering criteria are not affected by the Required Index Use Percentage setting and are always
allowed to run, because they typically do not have a negative impact on performance at the database.
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Allow Server ConnectionsAllow Server Connections
This tab lets you control who can access Server Side External Data. See Server side External Connections for more information.

To allow a user access to a server side connections:

1. Sign in as a user with DAS Administrator rights.

2. Click Admin | Security

3. Select a user

4. Click on the Allow Server Connections tab

5. In the Connection field select an available server side connection
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Masking SecurityMasking Security
Masking Security lets you mask any column or the entire row of any table using any type of criteria. A typical use of this security
is to hide sensitive HR information of some employees to a particular user but still allow that user to see non-sensitive
information in that HR table. This feature allows more of your users to be able to report on a sensitive table they might otherwise
have been barred from viewing at all.

Masking rules are defined for a table. A user is configured to use the masking rule. Whenever that user opens the table the
masking rule is built over, the data from the table is run through the masking rules in the background before the user gets to see
the data. The user is not aware a masking rule was run.

The table will be masked even if it is part of a join in a DASVIEW.

Note for World: If a table that is configured to be masked is part of a Logical View, all columns in the logical are masked. This is
because DAS does not currently introspect the Logical View and reliably determine what needs to be masked. In this event, these
Logical Views would need to be recreated as DASVIEW objects in DAS.

Performance Note: This feature requires extra DAS client-side processing resulting in a slight performance penalty. Our standard
Address Book masking feature has no such performance penalty. We recommend that you first attempt to use Address Book
masking first and then only use our more generic Masking Security if your business rules require a more complex solution.

Do the following to mask a table:

1. Sign in as DAS Administrator.
2. Create a special 'Masking Security Report' against a table. This is accessed using the Admin|Row Security Reports menu

command. These special reports will contain all of the masking logic. 

3. To add a new masking report, click Add. A masking report is created over JD Edwards World or Enterprise One tables only.
You cannot create a masking report over a business view, logical view, or external database table.

4. Editing a masking report is very similar to creating a standard DAS report, though there are limitations to what can be used
in a masking report. In particular, calculations used must be based on data from a single row and cannot rely on grouping,
sorting, lists, or calculations that otherwise introduce new rows. The purpose of a masking report is to specify the conditions
under which a particular columns values should be masked or if the entire row should be omitted. To accomplish masking,
you will use 'Mask' calculations. The 'Mask' calculation takes any type of conditional input to determine whether to mask a
particular column for a particular row or remove the entire row from the returned data set. To ensure good performance of
a masking security report, the report should have the fewest number of calculations and columns required to determine
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what needs to be masked. When saving a masking report, DAS will automatically remove unused columns from the report. 

5. From the User Security dialog, map these special masking reports to users and/or groups or roles. This type of security is
inheritable from DASUSERS to roles/groups to user. See notes on security inheritance for more information. 
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Set Global Application SettingsSet Global Application Settings
There are certain options that you can set for all Data Access Studio users. To set these options:

1. Sign in as a user with DAS Administrator rights.

2. Click Admin | Preferences for all users...

DAS will display the "Settings for All Users" form which has four tabs:

General Tab

To Do This

Match the DAS Grid filter to the case-sensitivity of
your database

Check/Uncheck Case-sensitive queries. If your JDE database is case-sensitive
(typical), then leave this check box checked. If your JDE database is case-insensitive,
uncheck this box.

Record all user queries in the Audit Trail

Check Enable EnterpriseOne Auditing (note this option works for World also). To
instruct DAS to automatically delete old audit trail records, click Auto Purge
records older than and enter the number of days. The Audit Trail adds very little
overhead and can be turned on in production environments. To disable the Audit
Trail, uncheck this box.
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Set a global default date pattern

Enter a Microsoft .NET date format string. If a DAS user has a JDE date format, then
the JDE Date format will override this global setting. Also, if the DAS user designs a
report with a custom date format, that format will override this global setting.

If this setting is blank, then DAS will first check the JDE date format for the user. If
this is blank, DAS will use the date format for the client workstation as the default.

WARNING: If you set this value to a valid date format, you may possibly break pre-
existing queries that query for date in a different format.

Example date formats:

yyyy-MM-dd = 2007-01-01

d/M/yy = 1/1/07

We use the .NET 4.0 specification for standard and custom date formatting
(http://msdn.microsoft.com/en-us/library/az4se3k1(v=vs.100).aspx). See this
specification for more date formatting options.

Drilldown query limit Limits how big the query for a drill down can be. Lower this number if users
experience a delay when using the Drill Down features from one grid to another.

Change the default editor/viewer for how-to and
design notes.

Change the option on the Notes Viewer option. Your end-users will be able to
override this selection from their workstation from their File|Default Preferences
dialog. There are two types:

Fully featured viewer - In addition to viewing and editing rich-text
formatted (RTF) documents, this option supports printing, searching, and
zooming among other features. There is some initial load time when this
viewer/editor launches.
Fast viewer - This option supports basic viewing and editing RTF documents
but comes up much faster than the fully featured viewer. Select this option if
most of your end-user client workstations are slow.

Permissions Tab
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To Do This

Hide the public Unassigned Folder

Check/Uncheck Hide Unassigned folder from Published Reports. Select this
option if you want to show a newly published reports only if a Folder Admin moves
the report to a specific folder. If left unchecked (default), then when users publish
reports, they will always at least be visible to the subscriber from the Unassigned
Folder.

Set how to resolve multiple user roles for *ALL
option

Select Union Merge (default), First Wins or Union Merge (5.3). Union Merge will
merge grant permissions for all roles. First Wins will select the first role. Union
Merge (5.3) is for backwards compatibility.

Select how A9.3 or later World customers will view
their published reports. These customers can select
how a user's groups are selected for viewing a
published report when that user logs in with the
*ALL role. This is important when applying business
unit security on a report when that security is
implemented using groups.

Select one of the two options of Published Reports Business Unit Security:

Use published-to groups(s) only - An end user running with the *ALL role
will view a report published to a group using just that group's business unit
security scheme instead of all the groups that user belongs to. For example,
role A maps to group 1 and role B maps to group 2. If a report is published
to group 2 and the user was signed in with *ALL, this option will display the
report using business unit security from group 2 only.
Use all groups user is signed in to - An end user running with the *ALL
role will view a report published to a group using all the groups the user
belongs to. For example, role A maps to group 1 and role B maps to group 2.
If a report is published to group 2 and the user was signed in with *ALL, this
option will display the report using business unit security from group 1 and
group 2.

Allow DAS to use World's Search Type Security to
filter out rows in any table that contain address
book numbers. For example, if a user or group in
World is configured to not see employee records
(search type 'E'), this feature will hide any record in
any table that contains an address book number of
type 'E'.

Check Use World Search Type Security and enable and configure 'Name Search
Type' security from the Security Officer menu (G9401) in World.

URLS
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To Do This

Set where to download templates Default: http://reportsnow.com/RNTemplates_60/. Do not change unless directed by
ReportsNow.

eLearning URL
You can set the web page that loads when your users click the Training button on
the DAS homepage. By default it is set to the ReportsNow eLearning site:
http://www.reportsnow.com/elearning.md/. Do not change unless directed by
ReportsNow.

Publishing Defaults
This tab allows you to set the initial value for the standard publishing options when your report developers publish reports. The
'Report Options' are available to a report developer when publishing any report. The 'Excel Options' are only available when the
report being published contains an embedded Excel presentation.

These options only sets the initial value of these options. The report developer can change any of these options prior to
publishing.
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To suggest that a report designer Do This

Should publish reports that do not allow a
subscriber to change data selection in a published
report.

Uncheck the 'Allow user to change data selection' option.

Should all subscribers to hide and show columnsin a
published report. Check the 'Allow user to hide and show columns' option.

Hide the data tab from subscribers and only show
the embedded Excel presentation (if available). Check the 'Show Excel Presentation Only' option.

Not allow subscribers to change the embedded Excel
presentation (if available). Check the 'Make Excel Read Only' option.

Hide the Excel menus from the subscribers in an
embedded Excel presentation (if available). Check the 'Hide Excel Menus' option.

Hide the worksheets created by DAS in an
embedded Excel presentation (such as DASLink and
DAS_STYLES)

Check the 'Hide All System Worksheets' option.

5/2/2023 Data Access Studio 8.0.13 Administration Guide

2023 - ReportsNow Inc. 79 of 145



Generate SearchGenerate Search
If your development creates custom JDE tables or adds media object types, you may want to re-generate the search so that users
can search for objects that reference these custom tables. Search generation takes approximately 5 minutes:

1. Sign in as a user with DAS Administrator rights.

2. Click Admin | Generate Search

Generally, keep all three options checked. When the search generation is done, you should see the generating search text
disappear. You will then see the search window where you can type search terms.
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View Audit Trail InformationView Audit Trail Information
Data Access Studio (DAS) provides an Audit Trail that records all queries in the DAS software. A DAS Administrator can then
review and purge the audit trail as necessary.

Additional benefit to EnterpriseOne
Although many databases support auditing, database audit tools typically do not work well with EnterpriseOne. This is because
EnterpriseOne maps many EnterpriseOne users to one database proxy user. Once mapped to the proxy user, the database audit
utilities will not be able to determine which EnterpriseOne user was responsible for which query.

The audit trail can be useful for the following:

Identify who submitted a query that needs to be terminated. Simply query for the table names and sort by most recently
used to see which EnterpriseOne users could have submitted the query in question

Identify inefficient queries. The Audit Log can show if a user is accessing the database inefficiently. For instance, if the user is
filtering on non-indexed columns or if the user is doing excessive table lookups as opposed to creating a business view to
do the same thing.

Identify unauthorized access. The Audit Log can show if a user is accessing a table that they should not be authorized to
access.

Monitor DAS Performance. The Audit log shows run times for the main select, load, and calculation operations. This will help
you identify poor running queries.

Monitor how DAS is utilized in your organization.

To enable the audit trial see Set Global Application Settings and refer to Enable EnterpriseOne Auditing. Once Auditing is
enabled, DAS will record database access for all DAS users. All records are stored in the FDASPROP table. Access recording will
continue indefinitely until you disable auditing.

Working with the Audit TrailWorking with the Audit Trail

To work with the Audit Trail:

1. Sign in as DAS Administrator.

2. Select Admin | Audit Trail.

You will see the following Audit Trail form below:
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Audit Trail Field Information it provides

Accessed Tables List the tables that the activity is accessing.

Activity

Defines the type of activity:

10 - Counting records

20 - Main Select

30 - Loading data

40 - Calculating data

User The JDE user that submitted the query from Data Access Studio.

Elapsed time
The time in seconds that the activity took to complete. All sub-second activities will
be rounded up to 1s when they finish. If an activity does not finish its elapsed time
will be 0.

User Type
0 - Designer

1 - Subscriber

Audit Record Size The size of the audit record. Useful to determine when to purge the audit records.

Audit ID The system-generated audit ID for each distinct DAS activity.

Access Date The date when the audit activity occurred.

Access Time The time when the audit activity occurred.

Examples of querying audit records

When you click find, you will see the most recent activity at the top of the grid. The default layout for the audit groups the related
activities together and sorts by the activity type. This shows you what any DAS report or layout does by its activity components.

TO QU ER Y
FOR INFOR MATION IT PR OV ID ES

Audit records
in general Enter filter values in the filter boxes. Click  Find.
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A specific table In the Accessed Tables column, type the table name with * before and after the name. For example, if you wanted to see
who accessed F0101, type: *F0101*. Click  Find.

A user Type the JDE user name in the User filter box. Click  Find.

Long-running
queries

Enter 10 in the Activity Type and enter something like >60000 in the Elapsed time filter. Click  Find. This will show
queries that took longer than one minute to execute.

TO QU ER Y
FOR INFOR MATION IT PR OV ID ES

P urging audit recordsP urging audit records

Only a DAS Administrator user has the authority to purge Audit Trail records.

To Information it provides

Purge select records
1. Highlight the audit record.

2. Press  Delete.

Purge all records Click Clear All.

Automatically purge old records Enable Auto-Purge as described in Set Global Application Settings

V iewing Audit D etailsV iewing Audit D etails

By default, the audit record shows an outline of the query. This shows what tables were accessed, what layout was run, what filters
and sorts were used. This detail information can be useful in identifying what precisely a user did on any given query.

You may also choose to display this information in XML format. This format may be useful if you want to export the audit
document to a third party tool for further analysis and reporting.

Repor ting on audit in formationRepor ting on audit in formation

As with any DAS grid, you can customize the grid as you need and save the grid as a layout for future use. See Maintaining
Layouts for more information.

Performance ConsiderationsPerformance Considerations

Turning on the audit trail does increase the amount of database and network traffic in your system. Data Access Studio makes
every effort to minimize this overhead as much as possible. The users should not experience noticeable delays when the Audit
Trail is on.

You may want to purge the Audit Trail records if you begin to notice significant delays.
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Managing User ObjectsManaging User Objects
As DAS Administrator, you can see and manage all reports and other objects in Data Access Studio. This privilege lets you copy
and delete reports. Some operations, such has managing tasks, may be done by non-DAS Administrators with certain
permissions.

This can be useful if a user leaves the company or if a user changes their JDE user name.

Copy Reports from user to another user
Copy a private or public report from one user to another.

Delete a private or public report for a user.

Delete a mobie Dashboard or ProReport

Transfer all Reports during a JDE upgrade
Transfer Everyone's Work

Transfer Tasks in Scheduler
Transfer a user's tasks to another user

See also Managing mobie content for information on Tasks that publish data to mobie.
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Control All User ReportsControl All User Reports
IMPORTANT

The following steps assume that you signed in as a DAS Administrator.

As DAS Administrator, you can see and manage all reports in Data Access Studio. This privilege lets you copy and delete reports
for any user. This can be useful if a user leaves the company or if a user changes his/her JDE user name.

As DAS Administrator, you will see two additional toolbar buttons:

Copy a Private or Public Report from one user to another
WARNING

Copying a report does not copy its dependencies. For example, when copying Burst Drivers, Dashboards or ProReports, it does not copy the
underlying reports that these viewers depend upon.

P rivate Repor tP rivate Repor t

1. Click the All Items toolbar button for private Reports. DAS will open in the corresponding form.

2. Type the name of the user to copy from in the Owner filter.

3. Click  Find.

4. Multi-select the layouts for that user by clicking the rows in the grid and holding down the CTRL key or SHIFT key.

5. Click Copy from user to user.

NOTE

Not available in All Published Items

6. In the resulting message box, enter the destination user and click OK.

7. Click OK on the confirmation message box.

P ublic Repor tP ublic Repor t

1. Click the All Published Items toolbar button for public reports. DAS will open in the corresponding form.

2. Type the name of the user to copy from in the Owner filter.

3. Click  Find.

4. Multi-select the published reports published by the prior user by clicking the rows in the grid and holding down the CTRL
key or SHIFT key.

5. Save the selected reports as a private report by clicking Save to Private Report:

6. Click the All Items toolbar button. DAS will open the corresponding form.
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7. Click Copy from user to user. Select the new user to copy the reports to.

8. In the resulting message box, enter the destination user and click OK.

9. Click OK on the confirmation message box.

10. Give the new owner the right to overwrite other users published reports.

11. Request the new owner to re-publish  these new report(s) to take over ownership of the published reports.

12. Remove the permission to overwrite other users published reports from the new owner.

Delete a Private or Public DAS Report for a user
1. Click the All Items toolbar button for private Reports or click the All Published Items toolbar button for public reports.

DAS will slide in the corresponding form.

NOTE

Deleting a published report from the All Published Items screen will delete the actual report. In order to delete a subscriber from a
report, instead, use the Manage Subscribers screen.

Deleting a published report from the All Published Items does not delete private copies of the report. Private copies of reports will
need to be deleted from the All Items screen.

2. Type the name of the user to copy from in the Owner filter.

3. Click  Find.

4. Multi-select the layouts for that user by clicking the rows in the grid and holding down the CTRL key or SHIFT key.

5. Click Delete.

6. Click OK on the confirmation message box.

Delete a mobie Dashboard or ProReport from All Items
Reports that have been published to a mobie portal also appear in the All Items screen. Deleting items from here will also delete
them from any portals they are associated with.

1. Follow the same steps as deleting a report from deleting a Private report from the All Items screen. The owner of these
items will be DAS_PUBLIC.

2. A dialog will appear displaying the message:

You have selected published dashboards and/or ProReports to delete. Deleting these object(s) here will delete them
from any portal.

3. Click Yes to delete the report.
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Delete snapshots from mobie
When a Dashboard or ProReport is published to mobie, a snapshot (a database table) is created to supply the Dashboard or
ProReport with the data from the underlying reports. These snapshots can be named or just use the Default name. To remove
those snapshots from your mobie DataBox, you'll need to do the following steps.

WARNING

Reports can be used by multiple Dashboard or ProReports. If there are any other Dashboards or ProReport that use these snapshots, these
Dashboards or ProReports will not work in mobie until the viewer is re-published.

1. Open mobie admin from Admin->mobie.

2. Find the report(s) that you want to remove. The number of reports depends upon how many reports your Dashboard or
ProReport uses. These reports will be under the DataBoxes->DataBox->DataBox reports section. 

3. There may be more than one snapshot associated with a report. You can delete all of them by selecting the report, clicking
the Delete button and Save.
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Transfer Everyone's WorkTransfer Everyone's Work
DAS stores all information about user reports in a table called FDASPROP in the JD Edwards system data source. If you perform
an upgrade of hardware or software that results in a new JD Edwards system data source, you will need to make sure to transfer
existing users’ work to the new installation. To do so, follow these steps

1. On you old system, export all user's work to a flat file:

1. Sign in as a DAS Administrator.

2. Click Admin | DAS Instance...

3. Click the Export button.

4. On the Export DAS Instance file dialog, click Save.

2. On your new system, import the flat file you created in step 1.

1. Sign in as a DAS Administrator.

2. Click Admin | DAS Instance...

3. Click the Import tab and click the Import button.

4. On the Import DAS Instance file dialog, select the .dasi file and click Open. If you want to overwrite the target with the
contents of the .dasi, check the "Overwrite target" checkbox (this is usually NOT recommended.)

Note to customers upgrading from a release prior to DAS 6.0: Importing an export created by a pre-6.0 system will result in all of
the previously published reports to now being published by a DAS Administrator. If you want to retain the published-by user on
the import, make sure to upgrade to 6.0 or later prior to exporting a DAS Instance. Another option is to perform a database copy
of the FDASPROP table found in your old system datasource to the new system data source.

EnterpriseOne note

The transfer will work regardless of the source and target Enterprise One releases. For example, you can export objects from non-
Unicode XE to Unicode E8.12.
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Transfer Scheduler Tasks to another UserTransfer Scheduler Tasks to another User
IMPORTANT

The following articles assume that you are granted the Can Manage Automator security permission.

The Modify Multiple Tasks form allows an admin to change several different properties for the selected tasks.

Setting the User ID
If you need to change a task from the current user to another user, such as when a user is Off-Boarding or changing their JDE
user name, you can move all of a user's assigned tasks to a new user. Simply select the tasks in the Defined Tasks tab and click the
Modify Multiple Tasks toolbar button.

Check the Set User ID checkbox and select the new user. Once the new user is selected, the task will be assigned to the new user,
retaining all report and task options.

WARNING

It is not possible to automatically change the User ID for Tasks with private reports that use mobie distribution. Please see the section below for
the manual process of transferring such tasks to a new user.

Migrating tasks with mobie distribution
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IMPORTANT

The following steps assume that you are a DAS Administrator and that you can log into DAS as the original user.

Each mobie distribution task most likely has a Dashboard and/or ProReport that depends upon the report data (or Snapshot)
from that task distribution. In rare cases, the Snapshot data is used by a Power BI connector so there will not be a
Dashboard/ProReport consumer.

You cannot change the User ID in the Modify Multiple Tasks form for tasks with private reports that have mobie distribution. The
mobie-published Dashboards or ProReports that depend upon the reports in the task will need to be manually transferred
between users, and a new mobie publishing task must be created to replace the tasks of the original user.

TIP

When possible, use published reports for your Dashboards and ProReports since these Tasks can be transferred between users.

1 .  D etermine what D ashboard or P roRepor ts depend upon the repor ts in  th is mobie distribution task1.  D etermine what D ashboard or P roRepor ts depend upon the repor ts in  th is mobie distribution task

Tasks with mobie distribution are created to provide data for a Dashboard or ProReport within the mobie portal. This means that
for these tasks there will be at least one, and possibly multiple Dashboard or ProReport viewers that use this data.

Find viewers as the original userFind viewers as the original user

1. Get the report name in the task. You can find this information in the Selected Reports section of the task itself.

2. Log into DAS as the report owner and go to the My Workspace page. Find the report, right-click and choose Show Viewers.

Find viewers using a DAS  repor tFind viewers using a DAS  repor t

You can also download a report that will give you the Dashboard and ProReports that depend upon a specific DAS report.
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Regardless of how you find the viewers that depend upon the Task's report, they must be transferred to the new User.

2.  Copy the D ashboard or P roRepor t to the new user2.  Copy the D ashboard or P roRepor t to the new user

The simplest way to copy a Dashboard or ProReport to another user is to have the original user export it and have the new user
import it. This method automatically exports dependent objects. Note: copy user-to-user can be used but the admin would need
to deal with missing report dependencies.

TIP

This may be a good time to publish the private reports that the Dashboard or ProReport uses.

To export a Dashboard with its reports, open the Dashboard designer then choose File->Export This Dashboard.

To export a ProReport with its reports, open the ProReport designer then choose File->Export This ProReport.
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3.  Impor t the D ashboard or P roRepor t3.  Impor t the D ashboard or P roRepor t

Once the Dashboard or ProReport has been exported, login as the new owner and import the .das file by performing a File-
>Import.

4. Setup a new Scheduler Task4.  Setup a new Scheduler Task

Re-publish the Dashboard or ProReport to mobie using the same subscribers and schedule as the original Task.

5.  Remove the original task5.  Remove the original task

Once the new Dashboard or ProReport has been copied and published by the new user, you may want to remove it. To
accomplish this, select the task and choose Delete.
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6.  D elete old snapshot data of original repor ts from mobie admin6.  D elete old snapshot data of original repor ts from mobie admin

See also Managing mobie content for further information.

For additional information on copying reports, see Control All User Reports.
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Create and Manage FoldersCreate and Manage Folders
With DAS 6.0, DAS Administrator can make multiple users Folder Admins (see User Security | Grant or Revoke Application
Permissions).

Once a user is a Folder Admin, they can press the Edit button on Reports Published To Me to create/rename/move/delete
folders. Folder Admins are also responsible for moving reports from the Unassigned folder to a destination folder.

Only one Folder Admin may edit the folder tree at a time. If you are editing the folder, be sure to make your changes, save, and
exit the Folder editor so that other Folder Admins may access it. If a Folder Admin is editing the folders and another Folder
Admin tries to edit the folders, DAS will issue a message that indicates who is currently locking the folder tree.

The Role of the Unassigned Folder in Publishing:

When users publish reports:

1. If the report was not previously published, the report will appear in the Unassigned folder in Reports Published To Me. A
Folder Admin must then move this report to the desired folder.

2. If the report was previously published and place in a folder (other than the Unassigned folder), then the report will remain
in its assigned public folder.
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EmailEmail
Beginning with version 5.2, Data Access Studio supports email of report outputs to recipients. The DAS Email capability supports
SMTP (Mail), and Outlook Exchange.

In order to use email in DAS, you must setup DAS to reference your email system. Once setup, end-users simply enter normal
email addresses in DAS to specify email recipients. To setup your email provider(s):

1. Sign in as a user with DAS Administrator rights.

2. Click Admin | Email Providers...

TO INFOR MATION IT PR OV ID ES

Add a new email provider Click New Provider. See Define Email Provider

Edit an existing email provider Highlight the provider name. Click Edit. Alternately, double-click the email provider name. See
Define Email Provider

Copy an email provider Highlight the provider name. Click Copy

Delete an email provider Highlight the provider name. Click Delete

Make an email provider the default email
provider Highlight the provider name. Click Make Default

To Save all email provider changes Click Save.

Cancel any changes and exit Click Close. (without selecting Save first)

Email Provider
When you add or edit an email provider, you specify key email information so that DAS can utilize the provider:

SMTP Example
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Exchange Example

FIELD PU R POS E

Name Name of the email provider. DAS end-users will see the email provider as this name
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Provider
Type Select either Mail (SMTP) or Exchange.

Outgoing
mail
address

For SMTP, this is the name or IP address of the SMTP server. For Exchange, it is the URL for Exchange Web services. Please
contact your Exchange administrator for the appropriate URL. It is typically of the form https://exchange-
server/ews/exchange.asmx.

User
Name The user name to log into the mail account

Password The password to log into the mail account

Port For SMTP, the port for the email server (25 by default)

From
email

The email address you want to use to show emails that are sent from DAS. E.g. dasreport@mydomain.com (Note that most
servers require this to be the name of a configured mailbox.)

Enable
SSL Check the SSL checkbox, SSL Mode, and SSL Port to enable SSL.

FIELD PU R POS E

When you are finished defining your email provider, click OK to save the changes.

Advanced Settings
Connection T imeoutConnection T imeout

DAS waits for 200 seconds by default to connect to an email provider. If your system requires more time, set the
EmailConnectionTimeoutInSeconds setting in the remoting.txt file found in the installation directory of DAS on your DAS server
(example: c:\Program Files (x86)\ReportsNow\Data Access Studio\Remoting.txt).

Operation T imeoutOperation T imeout

DAS waits for 60 seconds by default when executing non-connection operations on an email provider. If you are experiencing
errors when performing such expensive operations like attaching report output to an email message, you might need extend this
timeout. You can extend this timeout by changing the EmailTimeoutInSeconds setting in the remoting.txt file found in the
installation directory of DAS on your DAS server (example: c:\Program Files (x86)\ReportsNow\Data Access Studio\Remoting.txt).
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Automator (Scheduler)Automator (Scheduler)
DAS allows authorized users to schedule reports to run on defined Automator servers. The output of these reports can be
emailed, saved to the file system, or even saved to a database (via our mobie® product). This section discusses how to set up the
Automator so that your users can schedule reports.

Overview

Features of the Automator:

Schedule a report or a set of a report to run on a recurring schedule.
Run multiple reports at the same time on a server.
Have multiple servers run reports
Output reports in many different formats and distribute the output via e-mail or the file system
Auto load balance report running across all servers with no configuration
Allow any task to be directly assigned to a specific server

ServerServer

Data Access Studio Automator system is a fully muti-queue, multi-server, multi-output report running system. Each server can
have unlimited queues (i.e. tasks running at the same time) and, for a licensing fee, additional Automator servers can be
configured. Server configuration and task history are stored in the centralized FDASPROP table.

An Automator server defines the resources available to run reports. Considerations:

Microsoft Office is required to be installed if reports with Excel presentations are to be run.
If Microsoft Office is installed, an administration-level user that has run Excel at least once must run the Automator
Windows service.
If a report requires access to a server-side external data connection, the data connector drivers supports that connected
needs to be installed.

An Automator server has the following configuration settings:

Run Limit - Number of minutes that a task is allowed to run. Default is the run limit defined in the global run settings.
Assigned Tasks and Task Tags - By default a server will run any task. Assigned tasks or tags at this level will cause the
server's queues, by default, to run just those assigned tasks (or asks with the assigned tags). The queues can override with a
different set of assigned tasks or tags. It is recommended to always have at least one server and one queue) that can run
any task.

QueuesQueues
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A queue is the Automator server component that actually runs DAS reports. Each Automator server can have many queues. Each
queue executes tasks at the same time on a server so consideration of resources must be made when adding queues. While
ReportsNow recommends one GB per queue, every task is unique in terms of how it loads, processes, and outputs data.

A queue has the following configuration settings:

Run Limit - Number of minutes that a task is allowed to run. Default is the run limit defined by the server.
Assigned Tasks and Task Tags - The set of tasks and/or task tags (categories of tasks) that will only run on this queue. By
default, a queue will inherit the server's assigned tasks & tags. A queue can override the server assigned tasks and tags.
Note that it is not possible for a queue to allow any task if the server has assigned tasks & tags.
Trace Level - Trace logging level for the tasks running in this queue. Will create the same log as the DAS.log file created
during an interactive run of a report. Valid values are Disabled, 0, 1, or 2 with 2 being the most detailed logging. The default
is Disabled.
Detailed Server Logging - This enables detailed database-level logging. Enable this if you want to see the actual SQL
statements sent to the database. For JDE E1 and Xe, this setting enables the jdedebug.log for the report run. Note that this
setting can quickly generate a very large log file on the server.

Task H istoryTask H istory

Task History contains a record for each attempted report launch containing the following attributes:

Actual launched date & time
Scheduled date & time
Task result
Task duration in seconds
Queue and server name where the task ran
Any logs produced during the run of the task

LicensingLicensing

NOTE

Before you can use the Automator, you must have a license to run it. Contact ReportsNow (support@ReportsNow.com), for information to
purchase an Automator license. Note that you can have as many Automator server definitions you want but you can only have as many
running Automator servers as you have Automator server licenses.

Once you purchase and receive your Automator license. Apply your license as follows:

1. Run DAS
2. Click Help | Import license
3. Import the Automator .dasl license file

Once you import the Automator license, you may continue to configure and enable the Automator to run on your system.

User SecurityUser Security

NOTE

You must enable your users with the 'Can Schedule' permission before they can schedule jobs. In addition, there are several Automator
management permissions you will want to consider assigning to power users and/or administration for the purpose of managing Automator jobs
on the server. See Scheduler Permissions for more information.

Administrat ionAdministrat ion

The Can Manage Automator permission allows any user to become an Automator administrator. This is useful in situations where
you might want certain power users the ability to manage report running but you do not want to give access to them DAS
Administrator rights to those same users.
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Automator TaskAutomator Task
Overview

The only thing that the Automator runs are Tasks. A Task is created by authorized users and defines the reports the server should
run and when the server should run those reports. A task is made up of the following:

The set of reports to run The reports must be accessible (owned by or published to) the owner of the task.

The login information of the user (user ID, environment, and role). The password is securely stored separate from the task.

The output definition for the reports: email message and addresses, file location, or mobie® database.

The recurring schedule defining when the task will be launched.

The time zone that will be used to schedule start times for the task. By default will use the owning user's local time zone but can
be changed to any time zone.

A set of tags (i.e. categories) that will be used by the server to assign the task to queues. For example, a tag could be created and
call 'Priority One'. A queue could be setup to run only 'Priority One' tagged tasks. User must have the proper security to change
these options. See Scheduler Permissions for more information.

Options about what to do with missed tasks while the Automator server is down. These options will also be used for any tasks
running when the Automator server goes down for any reason. User must have the proper security to change these options. See

Scheduler Permissions for more information.

Launch a single missed instance of a task (default)

Launch all missed instances of a task

Do not launch any missed tasks.

Options about what to do if a Task ends in error. User must have the proper security to change these options. See Scheduler
Permissions for more information.

Do nothing (default).

Relaunch the task after a user defined amount of minutes. The task will relaunch a user defined amount of times.
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Users can only see and edit their own tasks. DAS Administrator (or users given the permission to manage Automator - See
Scheduler Permissions) can manage all user's tasks.

Time zone note for customers upgrading from version 5 or 6 with tasks created prior to version 7: The global Automator run
settings allows you to set a legacy time zone that will be used for all your pre-version 7 created or modified tasks.

Maintenance
As DAS Administrator (or a user given the permission to manage Automator - See Scheduler Permissions), you can view all
scheduled tasks by clicking the main 'Scheduled Reports' button from the home page of DAS. From this view, you can filter on
any part of a task including what report(s) the task launches or what e-mail addresses the task sends results to.

To modify attributes of multiple tasks at the same time, select a set of tasks and click the 'Modify Multiple Tasks' button.
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From here you can update the following attributes:

Login Environment - JDE E1 enviornment or JDE World library list the task should run under.
Email Provider - The DAS Email provider to use if the task specifies output to email
User ID - Set the owner of the task. After setting this field, the old user will no longer see the changed tasks.
Tag - Add or remove Queue Tags for the purpose of managing where tasks are run
Recover Options - Specify what should happen when a scheduled start of a task is missed or if a task ends in error

See user guide for more information about actions that the regular user can perform on the 'Defined Tasks' tab of Scheduler.
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Automator InstallationAutomator Installation
Your main DAS web server will become your first Automator server after signing in as DAS Administrator. Use these instructions
to change your server to another server or add an additional server.

You must first have a DAS Web server up and running and have imported your Automator license.

If you have not already done so, create a DAS Administrator user.

Sign in as a user with DAS Administrator rights.

Go to Automator Server Control.

Click 'Add Server'. This will open the Server Setup window (if hidden) and brings up the 'Add Server' dialog:

Server Name : Name of the server

Network Address : Network identification of the server with two '//' in front. Usually the same name as the server but can be an IP
address.

Run Limit : Inherit - use the run limit defined in Global Settings, No Limit - reports will run as long as necessary, otherwise a
specific maximum number of minutes after which a task will be terminated.

After clicking OK, click the 'Add Queue' button in Server Setup. 

Change the current configuration (or add a new server definition) to the name of the new server.

Start the server.

Additional Technical requirements:

1. Because the DAS Automator can run reports unattended, ReportsNow recommends that you allocate 2 GB + 1 GB RAM per
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queue for Automator to run efficiently.

2. A real Windows User that has run Excel at least once on the DAS server must run the DAS Automator service.

3. Install the latest version of Microsoft Excel on the DAS Web Server. When the Automator runs, it will present report
outputs in Excel. The DAS Web server must have Excel (and the highest Excel version in your organization) installed.

5/2/2023 Data Access Studio 8.0.13 Administration Guide

2023 - ReportsNow Inc. 104 of 145



Automator Server ControlAutomator Server Control
Once you have setup the DAS Web server and imported your Automator licenses, you can control the Automator as follows:

1. Sign in as a user with DAS Administrator rights. or as a user given the 'Can Manage Automator' Permission

2. Click the Scheduler button.

3. Click the 'Server Control' tab

Main Toolbar
B U T TON PU R POS E

Refresh Reload all the data in all windows of the Automator Server Control. Server Control keeps track of most changes automatically
but it is sometimes necessary to reload everything - especially if other users make changes to tasks and/or server configuration.

Global
Settings Open up dialog for managing settings all Automator servers will use. See Run Settings section.

Layout
Select a user defined layout of all the windows of Automator Server control. These layouts save window positions, grid column
configuration, grouping, etc.. The 'blank' layout is the default layout that will always be the initial layout on load. New named
layouts can be created and deleted as desired.

Server Setup

Clicking the 'Server Setup' button on the right side of the Server Control window brings up the window that allows you to
add/edit servers, queues, and tags.
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Servers
Displays the main running state of each Atuomator Server. An Automator server has multiple states:

Need license - Automator did not find a valid license and therefore cannot execute requests
Need DAS Administrator login - DAS Administrator did not log in prior to Automator service running. In this case, stop
and restart the DAS Automator Service on the DAS Web Server (see Windows Services)
Stopped - Automator is set to run, but is currently stopped
Active - Automator is running and processing scheduled requests
Disabled - Server is disabled in configuration
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B U T TON PU R POS E

Add
Server

Opens up Server Setup and prompts to add a new server. Any number of servers can be added but you can only enable servers
to start up to your Automator license count.

Edit Opens up Server Setup to this server's node. Use this to enable/disable the server or adjust the run limit of tasks running on
this server.

View Log Brings up a log viewer displaying the currently running main log of the server. Corresponds to the DAS_AUT_xxxxxxxxx.log file
usually found at c:\ProgramData\ReportsNow\Logs on the server.

Queues
Displays the queues in the system. A queue can have multiple states:

Idle - queue is enabled and ready to run tasks.
Disabled - queue is disabled.
Initializing <Task Name> - The task is starting and attempting to log in.
Running <Task Name> - The task is running reports.
Terminating <Task Name> - The system is in the process of terminating a task.

B U T TON PU R POS E

Set Trace
Settings Allows changing the trace log settings for an already running task.

Add
Queue

Opens up Server Setup and prompts to add a new queue for the server of the currently selected queue. Any number of queues
can be added on a server. Take note of you server capacity (memory and CPU) as you add queues.

View Log Opens up a text file indicating the details of the task (actual start time, reports to run, etc.) and any reported errors from the
task's error log.
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Edit Opens up Server Setup to the selected queue's node. Use this to enable/disable the queue or adjust the run limit of tasks
running on this queue.

Terminate Terminate the running task in the selected queue. This button will only show while selecting queues that are running tasks.

B U T TON PU R POS E

Upcoming Tasks
Displays the task instances that are scheduled to run or have been submitted manually. A task instance can have multiple
submission types:

Scheduled - The most common type. Indicates that this instance was submitted via the recurring scheduled defined in the
task. Unlike all the other submission types, this type cannot be canceled.
Waiting for available queue

A scheduled instance that is past its scheduled start time.

Queue Now - A manual submission of a task from the main Scheduler window ('Defined Tasks'). Any user can submit their
own tasks manually and an administrator can submit any task in the system.
Launch of missed instance - Submission of task that supposed to launch when the Automator server was down.
Launch of instance terminated at server shutdown - Re-submission of a task that was running when the Automator
server was shut down and then restarted.
Restart of failed instance: <scheduled start time> - Submission of a previous task that ended in error.

B U T TON PU R POS E

Edit Brings up the task editing dialog for the selected task instance.

Cancel Submission Allows canceling non-scheduled submissions (such as Queue Now)

If it has been over an hour since the scheduled start time of task instance, Upcoming tasks will change the clock indicator to a
yellow exclamation point indicator to show that the Automator server is backing up. If this happens, you will want to consider
adding queues to the server or adding additional servers.
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If the system is configured to run only specific tasks (in other words, all queues have specific task & tag assignments), then tasks
that are not assigned to any queue will show up as red in Upcoming Tasks. At this point, you will want to either create a queue
that can run any task or assign the tasks shown in red to specific queues.

Task History
Displays the history of ran tasks. A task can have multiple Results:

Success - The task ran to completion without any errors.
Error - The task ran to completion with items in the error log.
Terminated - The task was terminated by the user or administrator.
Exceeded Time Limit - Terminated - The task ran to the defined run limit of the queue.
Initialization Error - The task failed to log in to the system before time out as defined by the sign-in time out in web setup.
Failed to Get Password - Failed to retrieve the user's password from DAS's encrypted password store.
Server Shutdown - Task terminated as a result of the server shutting down gracefully.
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B U T TON PU R POS E

View Log Opens up a text file indicating the details of the task (actual start time, reports to run, etc.), any reported errors from the task's
error log, and any other trace logs (if available).

Edit Brings up the task editing dialog for the selected task instance.

Delete Deletes the selected history rows.

Server Logging
From Server Control, it is possible to view the main Automator server log and logs generated by individual tasks.

The Automator server log shows the basic information about launching and monitoring of tasks. This log viewer will always show
the DAS_AUT.log file (default location on the server will be c:\programdata\reportsnow\logs\das_aut.log). This log file will not be
cleared on a server restart. Instead, it will append log entries and then rotate the log file when it gets sufficiently large (default is 1
MB - limit can be changed in the Remoting.txt file found in the same directory as DataAccessStudio.exe on the server).

The log viewer for a task can be launched from Task History or from an active queue. If tracing is disabled and the task ended or is
running successfully, the log viewer will only show the 'Details' tab. Otherwise, it will show other log files, the number of files
based on how many database access processes are required to run the task and how detailed the logging is.

The default location for task log files on the server is c:\programdata\reportsnow\logs\<task name>. You will want to periodically
delete log files from these directories especially if trace logging is enabled since trace logs can get very large - especially if server
debugging is enabled..
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Automator Global Run SettingsAutomator Global Run Settings
Global Automator Settings that apply to all your Automator servers and queues can be accessed from the 'Settings' tool bar
button on the Automator Server Control tab.

TO PU R POS E

Limit the amount of time
any report is given to run

Change the Limits value to the maximum report time execution in minutes. This is the global setting. Each
server and/or queue can set its own run limit (including having no limit at all).

Limit the number of times
the automator server will
attempt to initialize.

The Automator service attempts to login using its cached DAS Administrator credentials. If the password in
these cached credentials is incorrect due to a recent password change, this setting limits login attempts to
avoid a lock out of a DAS Administrator account.

Send email notification on
execution error

Check the Errors checkbox. Specify a valid Email and Email provider for the notification. IMPORTANT: Set
up a valid email provider first

Send email notification on
task completion Check the Each report completion checkbox. Specify a valid Email and Email provider for the notification.

Set the time zone of older
tasks not created or edited
in 7.0 or later.

DAS 6.0 and before did not support a time zone attribute for tasks (used the Automator server time zone
instead). This setting will be used for those older tasks. This setting defaults to the upgraded DAS server time
zone.
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Server side External ConnectionsServer side External Connections
Server side external connections are external data connections that are provisioned on the DAS server for use by clients that have
been granted permission. Client side connections are made to data sources from individual client machines and are not shared,
while server connections access data on the DAS server and transfer the results to the client much as is done with JD Edwards
data. If users wish to publish reports that use external data connections, they should use server side data connections to ensure
that the connection to the data provider will be uniformly available to those users to whom the report is published. Server side
connections also relieve non-technical end users of the burden of understanding how to connect to external data sources and
ensuring that their client machines have appropriate data connectivity drivers available.

Creating new server connections must be done on the DAS server. It is recommended, though not required, that you log in as a
DAS Administrator user on the DAS server to create server connections. When on the DAS server, select File | New | External
Data to show the external data connections panel and the following additional menu options will be available when clicking on
New to create external data server connections:

Selecting to create a 32 Bit Server Connection or 64 Bit Server Connection leads to the same set of dialogs as shown when
creating client side connections, but the connections are created as server connections. Please see the instructions in the User's
Guide for how to provision an external data connection.

When creating server connections, it is important to create them in such a manner that the data connection driver will not present
any user interface or password prompting. For connections that require a password, the password must be stored with the
connection. This is because the data connection is made by an unattended process on the server when initiated by the client
machine. The unattended server process will hang and prevent further client activity if it attempts to bring up a user interface. If
different user and password combinations are required for different users, you must provision separate connections for those
different user and password combinations.

Once a server connection has been provisioned, there are two important steps required to ensure that the connection is visible
and available to end users:

1. Users that should be granted permission to use the connection must have the security permission Can use server side
connections. Please see the topic Grant or Revoke Application Permissions for information on applying that permission.

2. Users must be explicitly granted permission to use specific server connections. Please see the topic Allow Server
Connections for information on granting permission to a particular server connection to a user or group of users.

Multiple DAS Web Servers
If your enterprise uses multiple DAS web servers and/or separate Automator server, consider the following:

Make sure all the servers have the same set and version of the database drivers supporting your external data sources.
Make sure that all of your web servers can connect the servers and/or file systems containing the external data.
If you are using ODBC data sources, make sure to register these ODBC data sources on all of your web servers.

Shared Resource Reliability
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When you provision a server side connection, that connection information becomes a shared resource. You must be cautious
when creating server connections to data sources that have poor support for multi-user access. For example, the Microsoft Excel
database access drivers do not work reliably if multiple users try to access the same Excel workbook at the same time.
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Running mobieRunning mobie  Administration Administration
To run mobie  Administration, select mobie® from the Admin menu in DAS.

NOTE

To use mobie administration, you will need to have administration rights within DAS, such as a DAS Administrator.

®®
®
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Editing Data in mobie®Editing Data in mobie®
Here are some tips to get you started using the mobie  Administration application.

Navigation
The mobie  Administration application shows the mobie  information in a hierarchical format in the form of a tree view. Clicking
on a node selects that node expands any children that node may have. As you select the tree nodes, the application’s toolbar will
change accordingly. For instance, if you want to perform an action on a DataBox, select the desired node and the toolbar will
update with the available operations. The tree view also supports some multi-select operations.

Deleting Existing Nodes
Most tree nodes support the Delete operation. To delete a node, simply navigate and select that node and click the Delete button.

Note: Some nodes have relationships and will cause related nodes to be deleted as well. For example, if you delete a mobie  User,
any subsequent dependencies of the selected user will also be deleted.

Editing Existing Nodes
To edit existing nodes, simply navigate to the desired node and select it. The property editor to the right of the tree view will show
the node’s properties.

Tree node proper t iesTree node proper t ies

Some properties are editable, appearing in a normal, bold font. And some are read-only and appear in a greyed-out font.

®

® ®

®
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Some properties are purely informational, such as the Updated date/time, and some properties can only be set at the time of
creation and cannot be changed once saved.

Saving Your Changes
When you’re satisfied with your changes, click the save button on the toolbar.

This will commit all of the changes you have performed.

Canceling Changes
The mobie  Administration application shows your changes as you go so you can see all of your changes at once before you save
them. There are a couple of different ways to cancel your changes:

1. When you add a new node, a + indicator will appear on the node’s image.

If you are editing the new node, you can cancel the add action by clicking the Cancel Add button on the toolbar.

®
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2. If you’ve made several changes already, you can cancel your changes by clicking the Cancel Changes button on the toolbar.

Managing Subscribers
To manage mobie subscribers for a Dashboard or ProReport, expand the Dashboard Subscriptions or ProReport
Subscriptions section of the portal.

Add a SubscriberAdd a Subscriber

To add a subscriber to a Dashboard or ProReport, first select the desired report. This will enable the Add icon on the mobie
Administration toolbar.

1. Click the Add button. This will add a new row below the name of the report. The properties panel will show a section for
Subscriber UID.
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2. Select a user from the Subscriber UID dropdown.

3. Click the Save icon to save changes.

D elete a SubscriberD elete a Subscriber

To delete a subscriber from a Dashboard or ProReport, first select the desired report.

1. Expand the arrow next to the name of the report.

2. Select the name of the user to delete.

3. Click the Delete icon on the mobie Administration toolbar.

4. Click the Save icon to save the change.

5/2/2023 Data Access Studio 8.0.13 Administration Guide

2023 - ReportsNow Inc. 119 of 145



Managing mobieManaging mobie  Users Users
Mobie users provide an association between a JDE user and Portal users, as well as defining the authentication requirements for
use in mobie  Portals.

®®

®
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Adding or Editing A mobieAdding or Editing A mobie  User User
To add a mobie  user, highlight the mobie  users tree node, then click the Add button on the toolbar.

mobie  User Dialog

To edit a mobie  User, navigate and select the mobie  user node in the tree view to see and edit the properties.

NOTE

When you have finished updating the mobie  user properties, you can save or click on your user node in the tree view to perform additional
updates.

EnabledEnabled

You can enable or disable this user within mobie  using the checkbox. All of the associated mobie  objects will remain intact, but
the user will no longer be able to access any mobie  content, such as logging in to a Portal.

License TypeLicense Type

A standard licensed user can belong to any number of portals and view any number of dashboards. A capped mobie user is
limited to special portals that restrict the number of dashboards allowed.

If mobie contains both Standard and Capped mobie users, mobie admin will organize users accordingly.

®®
® ®

®

® ®



®

® ®

®
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NOTE

Once a mobie user has been saved, certain fields such as License Type cannot be changed. In order to change a mobie user's License Type, you
must delete the mobie user and re-add them.

JD  Edwards or mobieJD  Edwards or mobie  user name user name

Use the visual assist to select the JDE user or type in the JDE user name.

NOTE

The mobie  User Name must be unique within mobie.

Type (user or group)Type (user or group)

The Type can be a User or a Group (defined in Windows). Choosing the Group Type allows the use of this Windows group identity
in publishing operations. Members of the group that are authorized to use mobie must still be registered individually for access.
Configuring a group allows users to publish dashboards to the group, such that any users that are also members of that group
will gain access to the dashboard.



®®



®
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Security Associat ionsSecurity Associat ions

In addition, you can add additional Security Associations to the user as well for Dashboard security and filtering purposes (see
Edit Security Associations for more information.) These include:

Address Number
Business Unit
Company

Saving a mobie User
Once you’ve made changes to a mobie user, either click the Save toolbar button to commit your updates or click on your mobie
user tree node for more operations. Once saved, the mobie users will be available for use within your mobie Portals.

Deleting a mobie  User
To delete a mobie  User, highlight the tree node and click the Delete toolbar button. Warning: deleting a mobie  User will
remove the user from all Portals in mobie.

®

® ®
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Edit Security AssociationsEdit Security Associations
Security associations are values that can be associated with mobie  users and subsequently used in defining data access security
in dashboards. Defining data access security in a dashboard is done by selecting “Edit Filter” in the “Security Filtering” portion of
the dashboard designer.

In the dialog that comes up, it is possible to add conditions that restrict the data that is viewable from within the dashboard. In
most cases, you will wish to add conditions that are based on attributes of the user that is viewing. Security associations are the
means for defining those attributes of your mobie  users.

For example, you may wish to limit a user to only seeing data where a company field from the data source matches the company
to which the user belongs. The following shows the filter editor being set to a condition where the “Order Co” column must match
a parameter called “SYS_Company”:

In the above example, “SYS_Company” is a parameter generated by mobie  based on a defined security association named
“Company”. The value of that parameter will be determined by mobie  when a dashboard is rendered based on the values of
those security associations for the currently logged in mobie  user so that data will be limited according to the user that is logged
in.

A set of default security associations are typically created when mobie  is first configured that capture users’ JD Edwards address
number, business unit, and company. Security associations are made available as parameters in dashboards with the prefix “SYS_”
prepended to the name of the security association. The set of available security associations can, however, be edited by an
administrator at any time by selecting the button on the mobie  administration toolbar.

Selecting this button will bring up a special Data Access Studio report. This report has a single data column called “USER” that
shows all configured mobie  users. Each visible calculated column in the report represents a security association definition and
the name of the definition is the caption name of the column. This allows you to create any calculation based on the user name
that defines the value of the security association. Most frequently, these calculations are table lookup calculations that lookup
values in JD Edwards master tables.

The SYS_Company parameter above contains a single value. However, if you create security association that returns multiple
values (delimited by semicolons) for example from a Table Lookup calculation that returns a "Filter: List Of Values" as the
summary, a Dashboard parameter will turn that list into set of discrete parameters, making multiple items easy and fast. The
process to use a multi-valued parameter is described below.

®

®

®

®

®

®

®

®
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When the special security association definition report is saved and closed, any newly added definitions (columns in the report)
will cause the values for those security associations to be recomputed and set for each mobie  user defined in the system based.

Note that the calculations shown in the security association report represent the default values for those security associations and
are not always recomputed. It is possible to manually change the value of a security association and save it, though this is not
generally recommended as any future refresh of the security associations will overwrite a manually supplied value. Refreshing
security associations based on the calculations defined in the security association report can be done by selecting either the
“mobie® users” node to refresh all users or a specific set of users and selecting the toolbar button to refresh the values.

NOTE

Note that you still must save changes in the administration panel after refreshing to ensure that your changes will be saved.

Using a Multi-Valued Security Association Parameter in a Dashboard
To make use of a multi-valued system parameter described above, follow these steps: In the Dashboard, ensure the parameter for
your new "SYS_" parameter is of Look-Up Setting of "Static List". This is typically determined automatically, but might need to be
set manually especially for non-Table Lookup created lists.

®
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Once you have a multi-valued system parameter, it is easy to filter the entire dashboard data set, using an "any of" operation,
which translates to a high-performance IN clause:

NOTE

Dashboards created prior to 8.0.11 will likely have these multi-valued parameters represented as simple strings, along with a complex string
operation to perform the actual filter. Changing to multi-value parameters will substantially improve the performance of these dashboards (up to
twice as fast), so it is highly recommended that you change these cases. Ensure the parameter's Look-Up Setting is set to Static List and use the
"any of" operation to test in your filter.
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Import Users
If you have a large number of mobie  users to configure, configuring them manually in the mobie  administration panel can be
tedious. To help with this task, mobie  offers the capability to import user configuration from a spreadsheet.

Please refer to this support article information on importing mobie users.

® ®

®
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User IdentitiesUser Identities
The user identity associates a Windows identity, simple user identity, or user principal name (UPN name) that users use to log in
to a mobie portal with mobie user names that are used in Data Access Studio when publishing content to mobie portals. Different
identity types correspond to different portal authentication types. The following table lists what identity types are available with
which portal authentication types:

POR TAL AU THENTICATION T YPE V ALID  U S ER  ID ENTIT Y T YPES

Windows Windows

Simple Simple

Public N/A

Azure Active Directory
Windows 
UPN 
Open ID Group (for groups)

Okta UPN 
Open ID Group (for groups)

Custom UPN 
Open ID Group (for groups)

For Azure Active Directory (AD) portals, the portal configuration allows you to specify whether Windows or UPN identies will be
used with that portal. See Adding or Editing a Portal for more information on choosing the portal identity type.

Add user identity
To add an identity, highlight the User Identities node under the mobie user and click the Add toolbar button. Choose the
Authentication type. For Windows, use the visual assist to select the domain user.
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For all other authentication types, type in the user or group name you wish to use. In order to use a mobie user in a portal, the
mobie user or group must support the same Authentication type as the portal.

5/2/2023 Data Access Studio 8.0.13 Administration Guide

2023 - ReportsNow Inc. 129 of 145



DataboxesDataboxes
DataBoxes are your external database connections for mobie  and are configured similar to DAS External Data Connections.

Add a DataBox
To add a new DataBox, highlight the DataBoxes tree node and click the Add toolbar button.

NOTE

Prior to adding a DataBox, a database must be installed and configured to work with mobie® (see MySQL Installation Guide)

Editing a Databox
To edit a DataBox, navigate and select the DataBox node in the tree view. The properties will show in the edit panel to the right of
the mobie  tree view.

NOTE

When you have finished updating the DataBox properties, you can save or click on your DataBox node in the tree view to perform additional
updates.

Connection I nformationConnection I nformation

To set the Connection Information, click on the visual assist to choose the Data Source type and the Connection Properties

Mobie supports MySQL, SQL Server and Oracle databases. Once you set the Server name, Login information and Database name,

®
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you can click the Test Connection button to verify the Connection Properties.

D ataB ox NameD ataB ox Name

After you set the DataBox Connection Information, a default Name will be generated and can be used or you can choose to
change the name.

NOTE

The DataBox name must be unique within mobie.

Table qualificat ionTable qualificat ion

This field specifies a database or schema name that is prepended to all database table names when accessing the DataBox. This is
typically only required for DataBoxes that are stored in an Oracle database, because it is not possible to specify a default schema
in the connection string.

Saving a DataBox
Once you’ve made changes to a DataBox, either click the Save toolbar button to commit your updates or click on your DataBox
tree node for more operations.

Deleting a DataBox
To delete a DataBox, select the DataBox node in the tree view and click the Delete toolbar button.

NOTE

Deleting a DataBox is an operation that cannot be undone. Once you commit the delete operation, the DataBox cannot be recovered.
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Managing PortalsManaging Portals
Portals are the mobie  web servers that your mobie  Users can sign in and use to view their mobie  content, such as
Dashboards.

® ® ®
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Adding or Editing a PortalAdding or Editing a Portal
When adding or editing a portal, the properties will show in the edit panel to the right of the mobie  tree view.

Authentication Type
This property determines which type of authentication the Portal supports,

Windows indicates that Windows Authentication is enabled on this server.

Simple indicates the Forms based authentication is enabled on this server. Note that groups are not supported for simple
authentication portals. Please see Simple Portal Configuration for more information.

NOTE

There can be only one portal per DataBox that uses Simple authentication.

Public portals require no login, so anyone who has access to a public portal can view all of the dashboards published to it. Use of
this authentication type requires a separate mobie license type.

AzureAD refers to Microsoft Azure Active Directory where authentication is performed by Microsoft Azure using the OpenID
Connect protocol. Note that when AzureAD is selected, another option will be present in the portal configuration called "Identity
type" that can have one of two values:

UPN: Stands for user principal name, which is the default setting. This is the setting to use if you are using Azure Active
Directory users that are not synchronized to on-premise Windows user names.
Windows: Best used when Azure Active Directory is synchronized from an on-premise Active Directory domain.

The identity type dictates which types of mobie user identities will be used in conjunction with the portal. In the case of UPN
identity types, mobie user identities of type UPN will be used. For groups, the identity type specified for the identities is "OpenID
Group". In the case of a portal defined with the Windows identity type, only users and groups with identity types of Windows will
be used. Please see AzureAD Portal Configuration for more information.

Okta is another third party identity provider solution that is supported by mobie. For Okta authentication, only UPN identity types
and corresponding "OpenID Group" for groups are supported. Please see Okta Portal Configuration for more information.

Custom is a means of configuring alternate OpenID Connect capable identity providers. Please contact ReportsNow support for

®
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more information on this option.

NOTE

Only mobie users and groups that support the authentication types supported by the portal configuration can be added to the portal.

WARNING

Once the Authentication type property is set, it cannot be changed, though the Identity type property may be changed for an AzureAD portal.

DataBox
This shows the name of the DataBox that the portal uses for its mobie  objects.

Remote FDASPROP
In most cases Portals will have the Remote FDASPROP enabled, meaning that the Portal content resides in a separate database
from your DAS instance. Remote FDASPROP is the preferred option.

Portal Name
Choose a name for your portal.

NOTE

The Portal name must be unique within mobie.

URL
This is the URL address of your Portal, and must be a valid URL address. Typically, the URL is:
http://YourMobieServerName/UniquePathName ex. http://CompanyABC/mobie

You may use the fully qualified name of your server (e.g. YourMobieServerName.YourCompanyName.com) or the IP address of
the server. Each portal must have a unique path name. This will be used as the virtual path name in IIS (Internet Information
Services). The mobie application files will be stored in the associated physical path.





®
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NOTE

To support embedding of content in other secured Web sites (such as JD Edwards), it is necessary to also secure mobie with an SSL certificate
and use an https URL. Please consult Microsoft resources for information on configuring SSL.
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Portal UsersPortal Users
Portal users must be added to a specific Portal to have access to it.

Add a Portal user
To add a user to a Portal , navigate to the desired Portal node, select the Portal users tree node and click the Add toolbar button.
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Editing a Portal user
To edit a Portal user, navigate and select the Portal user node in the tree view. The properties will show in the edit panel to the
right of the mobie  tree view.

EnabledEnabled

This checkbox allows the mobie  Administrator to enable or disable the Portal user on the Portal.

User NameUser Name

The User name drop down shows the defined mobie Users that match the Portal’s authentication type. Choose a mobie User from
the drop down list.

®

®
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Portal Configuration and SetupPortal Configuration and Setup
Once you have created your Portal, you can use mobie  Administration to deploy it.

Portal Setup

Log into DAS on the mobie® server, then choose Admin > mobie  to access mobie® Administration. 

NOTE

The Admin > mobie® menu requires the Is mobie administrator permission. Your mobie server may be the same server.

To deploy your portal in IIS (Internet Information Services), select the portal node and click on the Setup Portal toolbar button.

This will launch the mobie® Portal Setup application.

®

®
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WebsiteWebsite

The portal will be created under the website with this name. It is common to use the default value of “Default Web Site.”

It is possible to specify a different website name, such as "MOBIE Website" that will create a separate website definition in IIS.
Doing so, however, will require specifying IIS network bindings for the new site to define what name and ports should be used to
connect it. Please consult Microsoft documentation for information on configuring IIS websites when configuring these kinds of
advanced scenarios.

ApplicationApplication

This names the IIS application path for the registered portal. It is common to use the default value from the portal URL. In our
example, this would be: /mobie

This name is part of the portal’s URL and the default value is derived from the URL. This is the IIS virtual directory name (also
referred to as path) that is mapped to the physical directory where the mobie application files will reside.

Typical examples might be /mobie  or just /  if the mobie portal is the primary application of the website.

D estination PathD estination Path

This specifies a file path on the mobie  server where the files for the mobie  portal will be saved. It is recommended, though not
required, that the files be placed in a subdirectory of IIS’s main Web site path. The setup utility will default to a subdirectory
location defined based on the physical path of the selected website.

It is common to use the default value of C:\inetpub\wwwroot\defaultFromPortalURL . In our example, this would be 
C:\inetpub\wwwroot\mobie

I nstallat ion Z ipI nstallat ion Z ip

Select the mobie  installation zip file (MOBIEPortal.zip) that you downloaded from Reports Now. The version of this file should
match the version of Data Access Studio that you have installed.

D elete Exist ing FilesD elete Exist ing Files

Checked by default.

It is always recommended to leave this option checked so that existing files in the target directory are deleted prior to installing
the new version.

NOTE

All files in the Destination Path are deleted except the existing user modifiable settings in the web.config and whitelabel.css.

® ®
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Allow Embedding in I FrameAllow Embedding in I Frame

An inline frame (IFrame) is used to embed another document within a current HTML document. mobie  pages can be embedded
in an IFrame. For example inside a JDE Cafe 1 page.

This option allows you to specify that the mobie content from this portal may be embedded in other Web sites via an HTML
iframe. Note that under these circumstances, the portal should be configured to use a secure SSL URL. Modern browsers require
this to allow cookies used by the portal to function properly.

Clicking the Advanced button shows the Embedding Options dialog.

Check the Secure to have cookies require the HTTPS protocol.
Check the Third-Party Allowed to allow third party cookies.

NOTE

Should you encounter IFrame embedding issues, refer to the following article: Embedded mobie  dashboards fail to embed.

Additional Configuration
In addition to running the setup utility, mobie portal authentication types other than Windows and Public require additional
configuration options to be specified in the web.config file that is installed in the Web application directory as part of setup. Please
see the following configuration topics to match the portal authentication type that you have selected.

Simple Portal Configuration
AzureAD Portal Configuration
Okta Portal Configuration

Generate portal configuration
In cases where you cannot log in to Data Access Studio from the machine hosting the Web portal, you can use this button to
generate a portal configuration file that can be copied with the “MOBIESetup.exe” executable found in your Data Access Studio
installation directory to the machine hosting the Web portal. On the machine hosting the portal, execute MOBIESetup.exe and first
select the portal configuration file in the first field called “Configuration File”. The other fields of the setup utility are filled in as
described under “Portal configuration and setup”.

®
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Configuring a Simple Authentication PortalConfiguring a Simple Authentication Portal
When configuring a simple authentication portal, there are several settings that are required to ensure that the portal can send
email or SMS messages to end users as part of the user registration and password reset process.

These settings can be found in the web.config file of the portal installation. The following shows what the example section in that
file looks like:

    <!--
      The following settings are used when "simple" authentication is used to handle two-factor authentication 
via SMS and email.
      SMS account credentials are for a Twilio account. (See http://www.twilio.com/sms)
    -->
    <add key="SmsAccountIdentification" value="" />
    <add key="SmsAccountPassword" value="" />
    <add key="SmsAccountFrom" value="" />
    <add key="MailIpAddress" value="" />
    <add key="MailEnableSsl" value="[true|false]" />
    <add key="MailAccount" value="" />
    <add key="MailPassword" value="" />
    <add key="MailFrom" value="" />
    <add key="MailDisplayName" value="" />

If you are not using SMS, the SMS settings do not have to be provided. If you do wish to use SMS, those settings are for
connecting to the Twilio service.

The mail settings are as follows:

K EY/OPTION VALU E D ES CR IPTION

MailIpAddress DNS name or IP address of an SMTP server

MailEnableSsl "true" or "false" to indicate whether the SMTP server requires SSL

MailAccount The account used to log in to the SMTP server. Can be blank if the SMTP server does not require authentication.

MailPassword The password for the account on the SMTP server. Can be blank if the SMTP server does not require authentication.

MailFrom The email address that emails from the portal will be sent from

MailDisplayName The display name in emails that are sent from the portal

An example that uses Office 365 to send email might look something like this:

    <add key="MailIpAddress" value="smtp.office365.com" />
    <add key="MailEnableSsl" value="true" />
    <add key="MailAccount" value="mailsender@mycompany.com" />
    <add key="MailPassword" value="MailSenderPasswordHere" />
    <add key="MailFrom" value="mailsender@mycompany.com" />
    <add key="MailDisplayName" value="mobie Web Portal" />

5/2/2023 Data Access Studio 8.0.13 Administration Guide

2023 - ReportsNow Inc. 141 of 145



Configuring an Azure Active Directory PortalConfiguring an Azure Active Directory Portal
In addition to the configuration and setup procedures initiated from the mobie administration and setup utility, there are several
configuration steps necessary to configure mobie to authenticate with Microsoft Azure Active Directory.

Configuring an Azure registered application
To work with mobie, you must have a registered application defined in Azure for your mobie portal. Please consult Microsoft
documentation for detailed information on how to register an application. When using the Quickstart, select "Web application" as
the application type. The following notes specific settings that you should ensure are made for the application registration:

Authentication redirect URIs must point to the URL of your mobie portal (e.g., https://mycompany.com/mobie/)
Under Authentication settings, you must select "ID tokens (used for implicit and hybrid flows)". "Access tokens (used for
implicit flows)" is not required.
The application must be configured with a client secret. That secret must be recorded as it will be used in the next step to
configure the installed portal.
Under "Token configuration", add a groups claim to ensure that group information is available in the portal. You may select
the different group types that will be made available to the mobie portal and it is recommended that you otherwise leave
the default options to provide the "Group ID" token property.
Under "API permissions", ensure that all of the following Microsoft Graph delegated permissions are granted for your users:

Directory.AccessAsUser.All
Group.Read.All
openid
profile
User.ReadBasic.All

Under "Expose an API", define a scope for admin and user consent. You may use the default application ID URI and indicate
names that identify when consent is granted.

Once complete, make sure to record the following pieces of information from the Overview page:

Directory (tenant) ID
Application (client) ID
Client secret (should have been recorded when first created)

Updating portal web.config
The settings from your Azure application registration need to be placed in the web.config file of your portal installation. The
web.config file has a commented section labeled "Azure AD example" that you can uncomment and supply the necessary settings:

    <add key="OpenIDAuthentication" value="AzureAD" />

    <add key="ida:AuthorityUrl" value="https://login.microsoftonline.com/<Directory (tenant) ID>/"/>
    <add key="ida:ApplicationID" value="<Application (client) ID>" />
    <add key="ida:ClientSecret" value="<Client secret>" />
    <add key="ida:MobieServerBaseUrl" value="<Portal URL, e.g., https://mycompany.com/mobie/>" />
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Configuring an Okta PortalConfiguring an Okta Portal
In addition to the configuration and setup procedures initiated from the mobie administration and setup utility, there are several
configuration steps necessary to configure mobie to authenticate with Okta.

Configuring an Okta application integration
To work with mobie, you must register an application integration in your Okta directory. Please consult Okta documentation for
detailed information on how to register an application. When using the App Integration Wizard, the following settings should be
used:

Sign-in method should be "OIDC - OpenID Connect"
Application type should be "Web application"
App integration name can be whatever you like (e.g., "mobie")
Grant type: "Authorization Code" and "Implicit (hybrid)" should be checked
Sign-in redirect URIs should include the URL to your mobie portal with the suffix "/authorization-code/callback". For
example, "https://mycompany.com/mobie/authorization-code/callback".
Sign-out redirect URIs should include the URL to your mobie portal with the suffix "/AccountAD/SignOutCallback". For
example, "https://mycompany.com/mobie/AccountAD/SignOutCallback".

Once complete, make sure to record the following pieces of information:

Client ID
Client secret

Note that you will also want to use the Assignments tab in your Okta application integration configuration to associate users and
groups to your registered application.

Updating portal web.config
The settings from your Okta application registration need to be placed in the web.config file of your portal installation. The
web.config file has a commented section labeled "Okta example" that you can uncomment and supply the necessary settings:

    <add key="OpenIDAuthentication" value="Okta" />

    <add key="ida:AuthorityUrl" value="https://<Okta Tenant>.okta.com/"/>
    <add key="ida:ApplicationID" value="<Client ID>" />
    <add key="ida:ClientSecret" value="<Client secret>" />
    <add key="ida:MobieServerBaseUrl" value="<Portal URL, e.g., https://mycompany.com/mobie/>" />  
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Managing mobie® ContentManaging mobie® Content
During the Dashboard or ProReports publishing process, multiple mobie® objects are created and are described below.

This node contains the published report data from Dashboards or ProReports and Automator. Each report can have multiple
Snapshots, depending upon publishing preferences.

Snapshots
Snapshots are generated database tables created in the DataBox and represent a snapshot-in-time of a specific report. These are
created during the Dashboard or ProReports publishing process and can also be created from an Automator task that references
the same report.

Column Translat ionsColumn Translat ions

The column JDE to column name associations.

Table nameTable name

The name of the generated table in the DataBox.

Field Name Caption Translat ionsField Name Caption Translat ions

This shows the JDE to translated column captions.

Deleting Snapshots
Using mobie® Administration, you can delete Snaphots.

WARNING

Since Reports can be used by multiple Dashboards or ProReports, use caution in doing this as this will break any existing Dashboards or
ProReports that currently use the Snapshot.

To delete a Snapshot, perform the following steps.

1. Open mobie admin from Admin->mobie.

2. Find the report(s) that you want to remove. The number of reports depends upon how many reports your Dashboard or
ProReport uses. These reports will be under the DataBoxes->DataBox->DataBox reports section.

3. There may be more than one snapshot associated with a report. You can delete all of them by selecting the report, clicking
the Delete button and Save.
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